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When Probe first loads, the application's window will be empty.
You must open or create a study in order to load Probe's main
interface. To create a study, choose "New" from the File Menu.
This will open the wizard which will guide you through the
creation of a new study. After exiting the wizard, Probe's main
interface will be displayed and signal calculation will begin. While
signal is being calculated you can still use any of Probe's
functions. The Signal Progress Bar will appear at the top of the
main window while signal is being calculated. When the signal is
finished being calculated, you will be asked if you would like to
redraw the map. You can redraw the map at any time by pressing
the "Redraw" button (located on the Transmitter List Box).

Probe's Main Interface



General Toolbar

The icons on the general toolbar are shortcuts to common
operations such as creating a new study, saving and
loading studies, and printing.



Map Tools Toolbar

Using this toolbar, you may select one of Probe's
interactive map tools. These tools can be used to perform
tasks such as zooming, adding text, getting map
information, examining profiles, and counting population in
a rectangular region.

Functions Toolbar

This toolbar has shortcuts to some of the program's more
commonly used functions such as map settings, study
editing, contour overlaps, population reports, NAD
conversion, and access to the help file.

Transmitter List Box

This box contains a list of all of the transmitters in a study.
The "Transmitter List Box" can be used to choose which
transmitters are displayed and which color is associated
with a transmitter. There are four buttons at the bottom of
the transmitter list box. The "All" and "None" buttons are
used to automatically select all or none of the stations in



the list. The "Redraw" button can be used to force the map
to be redrawn (use this after changing a transmitter
selection). The "Display Options" button can be used to
access the "Display Options Window" which allows you to
set the map's properties.

Cutoff List

The cutoff list displays the currently defined field strength
value cutoffs and their corresponding colors.

Window List

The window list displays a list of all of the windows within
Probe that are open (population reports and profile plots
for example). Click on the name of the window you would
like to have displayed to make it appear.

Status Bars



Probe has two status bars located at the bottom of the
program window. The top status bar is used to display
information about the tool bars and menu items. When the
mouse is located over a toolbar or menu item, the top
status bar will show a description of the items functionality.
The status bar on the bottom is used to display information
about the study. This status bar displays the current
drawing mode and calculation status. It also shows
extended information about the map when the "Map
Information Tool" is used.

Terrain Toolbar

This toolbar shows the selected terrain configuration for
the current study. It is in the form of "Primary" /
"Secondary". If only a primary database for the study was
specified, that is all that will be displayed.

Map Settings Toolbar

The map settings toolbar displays the current center
coordinates of the map along with the map's scale and
projection.



Map Window

This is the display area of Probe's main window where the
map is drawn. Probe is designed to be a completely
WYSIWYG environment, so the map window will show you
exactly what will appear on the printed output. The map
window is set up to represent a sheet of paper containing a
map and several objects which can be added to the map
and manipulated. Items such as text and legends can be
placed anywhere on the map (these objects can be
interactively moved using the selection arrow, see Map
Tools for more information).
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To install insert the Probe CD in your CD-ROM drive. The setup
program should automatically start shortly after inserting the CD.
After running the installation program, you will need to set up the
paths to the various databases which Probe uses. To do so, run
Probe and select "Path Setup" from the View Menu. This will load the
Path Setup Form where you can select the paths to the databases.

Probe requires the use of a hardware key provided by V-Soft
Communications. A device driver for the key must be installed before
the program will run. Insert the CD-ROM labeled "HASP Installation"
and the install program for the device driver will automatically start.
When running Probe the key is used to check user authorization.
The key is a bi-directional device which plugs into your parallel
printer port or USB port. The parallel key is fully transparent to other
operations using the parallel port.
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Probe uses several databases which must be installed on the
computer. Choose "Path Setup" from the View Menu to setup or
change path settings.



To set up the path data you can enter the directory which
contains the specific database in the appropriate edit boxes, or
click the "Browse" button next to each edit box to find the
directory using a tree view.

The terrain path is configured using the Terrain Setup Window
and the census data paths are setup using the Population Data
Path Setup Window.
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Probe's terrain database setup can be configured by selecting
"Terrain Path Setup" from the "View" menu. Note - you cannot
have a project open when configuring the terrain databases.



Probe is set up in such a way that "terrain drivers" are used for
accessing various terrain databases. The terrain setup window
shows all of the databases that you have installed (so the list on
your computer may look different based on your situation).
Databases that appear to be correctly configured will show
"Tested Successfully" next to them. Click the "Edit Button" to
select the terrain driver file and supply the path to the actual
terrain data for the selected database:



The program will tell you the standard driver name for the
database that you are editing. Once you have setup the
database, click OK. Then check to see if the database list shows
"Tested Successfully". If it shows "Test Failed", then you have a
configuration problem.

Available Databases

The V-Soft US 3 Arc-Second Terrain Database

Terrain Driver: vsoft03.vtd



The V-Soft US terrain database has 3 arc-second data for the
48 contiguous states, Puerto Rico, and Hawaii. The path
must be specified to the location of the actual ".dat" data files.

The V-Soft 30 Second World Terrain Database

Terrain Driver: vsoft30.vtd

The V-Soft 30 second world terrain database covers the
entire world at 30 arc-second resolution. The path to the
"g30info.dat" data file for the database must be specified as
the path in order for it to work correctly.

The V-Soft 3 Second Alaska Terrain

Terrain Driver: vsoftak.vtd



The V-Soft 3 arc-second terrain database is based on an
older 3 second USGS Alaska dataset.

The V-Soft 30 Second US Database

Terrain Driver: vsus30.vtd

This is the older 30 arc-second NGDC terrain database that
is generally used for FCC contour calculation.

The NED 3 Second US Database

Terrain Driver: ned03.vtd



This is a US 3 arc-second database that was generated from
the 30 meter National Elevation Dataset.

The NED 3 Second AK Database

Terrain Driver: ned03ak.vtd

This is an Alaska 3 arc-second database that was generated
from the 30 meter National Elevation Dataset.

The NED 30 Meter Database

Terrain Driver: ned30m.vtd

This is the 30 meter National Elevation Dataset data.



Using Terrain Within The Program

The program can be setup to access two terrain databases at
any given time, a primary and secondary database. The primary
database is first used to obtain the elevation at a point. If the
elevation at the point in question cannot be found in the primary
database the secondary terrain database is accessed.
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The population database setup window lists all of the population
databases that are available to the program (databases that the user
is not authorized to use will not appear on the list). If the path that is
set up for a given database and data is found, "Tested Successfully"
will appear to the right of the database name. If the path is
incorrectly configured, "Test Failed" will appear and the database will
not function properly within the program. To configure the path to a
given database, select it with the mouse and click the "Edit" button.
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When a study is created using the wizard a number of default settings
are used. You can set these defaults by using the default settings
window which can be accessed by selecting "Study Defaults" from the
View Menu. The default settings window has four tab sheets with
various options (click on the tab at the top of the window to change
pages).

The General Options TAB



Signal Rendering

Set the default signal special effects used for signal drawing.

Calculation



Here you may set the default signal resolution and profile
spacing that appears in the wizard when creating new studies.
This setting affects the block size resolution. When the original
DTV allocation table was created, the FCC used a 2 km block
size. Blocks of smaller size give better resolution, however
smaller blocks require more processing time. A profile
increment of 0.1 km corresponds to a 3 arc-second terrain
database resolution.

Map / Page Settings

Click the "Set Default Layout" button to set the default layout
page settings (this will load the Layout Setup Form). The
default map scale is set in the edit box labeled "Map Scale",
the illustration above shows a default map scale of
1:1,500,000. A number of label items can be automatically
added to the map by checking the appropriate box. When the
study is created, Probe will try to find suitable locations for all of
the label items by examining the page layout settings. For
example, if you want the labels to appear along the left side of
the page, make the left margin larger than the other margins
(see Page Layout). Use the "Default Transmitter Token" button
to specify the transmitter token properties to be used by
default. Probe can also automatically add a company name to
the map. To show this name check the box next to "Show a
company name on the map" box and enter the company name
in the edit box below. The company name will always appear in
the upper right corner of the page when a study is created,
however it can be moved to any location by the user.



TV Interference Options

The "TV Interference Options" TAB allows the user to set default
options for the various television interference switches. These
switches match the options shown in the TV interference wizard.

Miscellaneous Options



Miscellaneous Options 1

Here a few miscellaneous options can be configured. Click on the
color box to set the default contour color used when adding new
contours to the map. The "Set the Default Transmitter Info
Template" can be used to configure the default format of
transmitter information that is placed on the map. The "Set the
Default Transmitter Info Display Properties" button can be used to
set the default appearance of the transmitter information box that
appears on the map.



Show Title With Population Reports

If this option is selected then the first line of the population
reports will reflect the title given.

Default Transmitter Type

This option sets the default transmitter type when adding
the first transmitter to a coverage study.

FCC Databases

Use this option to select which V-Soft FCC database the
program looks at when accessing FCC data. The "state
based" files have one file for each state. The FMR/TVR
master database has all of the database records in one file.

Census Database



Use this to set the default census database selection used
for population reporting. If the "Always use program
defaults" box is checked - then the program will always use
the defaults you have selected here and not show a window
asking which census database to use (Hint: turn this on if
you only have one census database installed).
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The wizard is used to create a new study (to open the wizard
choose "New" from the File Menu). The first step is selecting
which type of study you would like to run:

Coverage Study

A coverage study consists of calculating the signal
values for one or more transmitters.

FM Interference 

An FM Interference study is for examining the
interference caused to an FM station by others around



it.

D/U Study 

In a D/U, study a desired and any number of undesired
stations are supplied. The D/U ratio can be plotted on
the map, and population can be counted in user
defined D/U regions.

Incoming TV Interference (This is an optional feature)

An incoming interference study calculates interference
received by a given station using the FCC's rules
defined in OET Bulletin #69.

Outgoing TV Interference (This is an optional feature)

An outgoing interference study will calculate the
interference caused to other stations by the reference
station using the FCC's rules defined in OET Bulletin
#69.



General Interference (This is an optional feature)

This type of study allows the user to supply his/her
own D/U ratios for specified channel relationships to
define a custom incoming or outgoing interference
study.

The Second Page of the Wizard



This is where the terrain and geographic options for the study
are defined. Use the "Change" button to select the primary and
secondary terrain. Here the datum, distance and bearing
method, signal cell spacing, and profile increment for terrain
profile based calculations can be selected.

Continuing On

After clicking the "Next" button, the wizard will guide you through
a series of steps for specifying the parameters required for the
selected study type. Once you have selected the parameters
you want for each page, click the "Next" button to go to the next
step. At any time you may go back to the previous page by
pressing the "Back" button. Be aware that if you go all the way
back to the first page of the wizard, all of the information you
have entered on the subsequent pages will be cleared.
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After selecting "Coverage Study" from the first page of the
wizard and setting up the geographic options on the second
page, you are ready to begin defining the parameters for the
coverage study.

First Page - Coverage Options

On this page you have two things to consider. First, select
whether or not land cover will be considered in the coverage
study. The land cover attenuations can be selected by
clicking the "Setup Land Cover" button. Second, define the
default area of calculation to be used when adding
transmitters to the study. After you have selected the desired



values, press "Next" to continue to the next step.

Second Page - Stations to be Considered

Press the "Add" button to add a transmitter to the study.
Pushing the "Add" button will bring up the Transmitter
Properties Window where you can enter the parameters for
the transmitter (either by loading a station from an FCC
database or entering its parameters by hand). After entering
the transmitter information and pressing the "OK" button on
the transmitter properties form, the station information which
you entered will appear in the list. If you wish to edit a
transmitter's properties, select the transmitter by clicking on
its line in the list, then press the "Edit" button (or double click
on the transmitter you wish to edit). To remove a transmitter
from the study, select the transmitter and press the "Remove"
button.

Use the "Edit AOC" button to edit the "area of calculation" for
the selected transmitter. The "Match Propagation Settings"
button can be used to automatically configure the
propagation model (and model settings) of all the other
transmitters in the list to match the selected transmitter.



The "Cull" button can be used to access the advanced
database searching feature to load several stations from an
FCC database at once.

After you have added all of the transmitters that you wish to
include in the study, press the "Next" button to move to the
final step.

Third Page - Study Creation (Finish)

This is the final page in the wizard. If you wish to go back and
change anything in the coverage study, press the "Back" button.
If you are satisfied with the parameters entered press the
"Finish" button to display the map and begin signal calculations.
There will be a delay while the signal buffers are set up and the
study is created.
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After selecting "FM Interference" from the first page of the
wizard and setting up the geographic options on the second
page, you are ready to begin defining the parameters of the
study.

First Page - FM Interference Options

On this page you have two things to select.



Include Translators

This determines whether translators should be included in
the database search for possible interferers.

D/U Ratios

Here you can select to use the standard FCC D/U Ratios
(20 dB, 6 dB, -40 dB, and -40 dB), the old FCC standard
ratios (20 dB, 6 dB, -20 dB, and -40 dB), or you can opt to
specify your own D/U ratios to be used in calculating
interference within the study.

After choosing the desired parameters, press the "Next"
button to continue.

Second Page - Set Up Station To Be Analyzed



At this point you must define the reference station to be
considered for incoming interference. To do so, click the
"Setup Parameters" button, which will bring up a "Transmitter
Properties Window" where you can enter the station's
parameters or load from the FCC database. After setting up
the parameters you will be returned to this page.

To continue press the "Next" button.

Third Page - Define the Area to be Considered for
Interference

On this page there are two main boxes:

With Respect to the Main Station

This is where you define the area within which you wish to
consider interference to the main station. You have three



options for the area of calculation:

Within Protected FCC Contour

This will consider interference from other stations
inside the main station's protected FCC contour.

Within Other FCC Contour

Use this to consider interference within the main
station's contour other than its protected contour.
You may specify the contour signal cutoff (in dBu)
in the edit box labeled "Field".

Within Distance From Site

Select this option to consider interference to the
main station within a specific distance from the
transmitter's site. You can specify the distance (in



kilometers) in the edit box labeled "Distance".

With Respect to Interfering Station(s)

In order to reduce the calculation's required, and to decide
which stations from the database should be considered as
possible interferers, you must specify the area within
which possible interferers may be considered to interfere.
There are two options:

Within Interfering FCC Contour

Use this to consider stations that have FCC
standard method interference contours that overlap
the reference station's protected contour. When
calculations are performed only the area within the
overlap region will be considered for interference.

Within Distance from Site



Choose this item if you wish to consider every point
within some distance from the possible interferer's
site. You may specify this distance (in km) in the
edit box labeled "Distance". When calculations are
performed, only the points within the main station's
area of calculation that are less than the specified
distance from the interfering transmitter's site will
be considered.

Threshold for Reception

There is an edit box labeled "Threshold for Reception",
this specifies the minimum field strength that must be
achieved by the reference station at a point in order for
that point to be considered as having coverage (and thus
being evaluated for interference).

On this page there is also a switch labeled "Search FCC
Database for Potential Interferers". If it is checked, the FCC
database will be searched for all possible interferers given
the "Area of Calculation" criteria. If unchecked, the database
will not be searched and you will need to select or specify
potential interferers manually. After setting up the area of
calculation, press the "Next" button to continue. If you chose
to search the database, it will be searched at this time.



Fourth Page - Select Stations to be Considered

If the database was searched, this page will display a list of
all possible interferers (if not, the list will be blank). At this
point you can add, remove, and edit the transmitters to be
considered for causing interference. To edit a transmitter it
must first be selected (click on the station in the list to select
it), then press the "Edit" button. You may remove transmitters
from the list in the same manner. When you are finished
editing the transmitter list, hit the "Next" button to continue.

Fifth Page - Study Creation (Finish)

This is the final page in the wizard. If you wish to go back and
change anything in the interference study, press the "Back"
button. If you are satisfied with the parameters entered, press
the "Finish" button to display the map and begin signal



calculations. There will be a delay while the signal buffers are
set up and the study is created.
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After selecting "FM Interference" from the first page of the Wizard
and setting up the geographic options on the second page, you are
ready to begin defining the parameters of the study.

First Page - Reference Station Setup

Begin by specifying the reference station that you wish to use for
the study. This station represents the "Desired" station. Next
specify the calculation area, signal is calculated for each
transmitter in the study for this region. Specify the "Threshold for
Reception", this is the minimum signal that must be achieved by
the reference station for the point to be considered as part of the
study.



Check the "Force 10% time variability for interfering signals" to
cause undesired stations to have signal calculated using 10%
time variability.

Second Page - Interfering Stations

This list of stations represents the "Undesired" stations in the
study. More than one can be specified, however the same set of
D/U ratios are applied to all stations in the study - so generally
all stations included in the study should have the same channel
relationship with the reference station.

Third Page - Study Creation (Finish)

This is the final page in the wizard. If you wish to go back and
change anything in the interference study, press the "Back"
button. If you are satisfied with the parameters entered press the
"Finish" button to display the map and begin signal calculations.
There will be a delay while the signal buffers are set up and the
study is created.
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After selecting "TV Interference (Incoming)" from the first page
of the wizard and setting up the geographic options on the
second page, you are ready to begin setting up the parameters
for the interference study. For information on the procedures
used in calculating interference see DTV/TV Interference
Calculation Methods.

* Note - This feature is available in the optional DTV interference
module.

First Page - TV Interference Options



On this page you have four things to select.

Consider NTSC Taboo Interference

This box should be checked if you wish to consider taboo
interference into NTSC stations in the study. Leaving the
box unchecked will cause Probe to only consider co-
channel and first adjacent channel interference.

Do Not Consider KWX Error Points as Ix Free Coverage

OET 69 requires that KWX error points be counted as
"interference free coverage" regardless of the D/U ratio
and signal strength of the cell in question. Checking this
box will cause cells where KWX errors are reported to be
evaluated for interference (basically KWX errors will be
ignored). Note - it is important that you have this switch
turned on when trying to do 'real world' interference
studies that consider areas outside of the reference
station's grade B contour (see "DTV/TV Interference
Calculation Methods" for more information).



Apply NTSC LPTV/translator D/U rules

This causes the program to examine the channel offset
relationship when LPTV and translators are involved and
uses an adjusted D/U ratio when offsets are matching.

Force Beam Tilt = 0

This forces the program to ignore beam tilt settings found
in the FCC database and use the un-adjusted OET 69
vertical pattern for calculation.

Force use of OET 69 Longley/Rice Parameters

If this switch is turned on, then OET 69 Longley/Rice input
parameters will be used for calculation. If it is off, then the
program will use the parameters entered for the reference
station.



Use OET 69 depression angle determination

The OET 69 processing technology does not consider
terrain in its depression angle calculation (it compares the
height above ground of both transmitter and receiver and
calculates the depression angle from that). If this option is
turned on, then Probe calculates depression angles this
way. If it is off, then the depression angle is determined
using the AMSL heights of the transmit and receive points.

Force LR time variability to 10% for interfering signals

This option should be turned on for FCC compliance.
Uncheck this option to have the program use the time
variability entered by the user for evaluation.

Database Cull Options

There are several options on the right hand side of the
window that allow the user to determine which stations
are to be included in the study.



Include CPs

Include construction permit records in database search.

Include APs

Include application records in database search.

Include Translators

This determines whether translators should be included in
the database search for possible interferers.

Consider DTV Allotments

Include stations contained in the FCC DTV allotment
database in the database search.



Consider STA Records

Include special temporary authority records in the
database search.

After choosing the desired parameters, press the "Next"
button to continue.

Second Page - Set Up Station To Be Analyzed

At this point you must set up the reference station to be
considered for incoming interference. To do so, click the
"Setup Parameters" button, which will bring up a "Transmitter
Properties Form" where you can enter the station's
parameters or load out of an FCC database. After setting up
the parameters, you will be returned to this page, click the
"Next" button to continue.



Third Page - Define the Area of Calculation

Area of Calculation

Within reference station's NL (Noise Limited) contour

This is the standard area of calculation of OET 69
interference studies.

Within NTSC counterpart station's NL contour

In some cases interference should be analyzed within
the reference station's NTSC counterpart contour.

Within a user specified FCC contour



Select this option to consider interference within an
arbitrary FCC contour [F(50-50) is used for NTSC an
F(50-90) is used for DTV].

Within a given distance from the reference transmitter

This option will consider interference within the
specified distance from the reference transmitter.

Radial Options

Use only 8 radials for HAAT calculation

The OET 69 processing methodology uses only 8
radials of HAAT calculations (and interpolates values
for radials in between). If this box is checked, the
program uses the OET 69 method. If unchecked, then
the HAAT is calculated for each radial of the contour.



# of Radials

The OET 69 methodology uses 72 radials for contour
calculation. The user may select 8, 36, 72, or 360
radials for generating the protected contour.

Threshold for Reception

The threshold for reception is the minimum field strength
a cell must have in order to be considered for
interference. By default, this is the dipole adjusted grade
B field strength.

Search FCC Database for Potential Interferers

If this box is checked, the FCC database will be searched
to find stations that may interfere with the reference
station. If unchecked, you will need to manually enter
each station you wish to consider in the interference
study.



To continue, press the "Next" button. If the "Search FCC
Database" box is checked, Probe will find potential interferers
before continuing to the next page.

Fourth Page - Select Stations to be Considered

If the database was searched, this page will display a list of
all possible interferers (if not, the list will be blank). At this
point you can add, remove, and edit the transmitters to be
considered for causing interference. Before removing or
editing any transmitters, they must first be selected (click on
the station in the list to select it). The "Import List" and
"Export List" buttons can be used to save and restore a
transmitter list (if you plan on creating multiple studies with
the same transmitter list, you can export the list to a file and
then import it in a later study). When you are finished editing
the transmitter list, hit the "Next" button to continue.

Fifth Page - Study Creation (Finish)



This is the final page in the wizard. If you wish to go back and
change anything in the interference study, press the "Back"
button. If you are satisfied with the parameters entered, press
the "Finish" button to display the map and begin signal
calculations. There will be a delay while the signal buffers are
set up and the study is created.
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After selecting "TV Interference (Outgoing)" from the first page
of the wizard and setting up the geographic options on the
second page, you are ready to begin setting up the parameters
for the interference study. For information on the procedures
used in calculating interference see "DTV/TV Interference
Calculation Methods".

First Page - TV Interference Options

Nearly all of the options on this page are the same as for the
Incoming TV Interference Study. Please see the section
about Incoming TV Interference for more information on
those.



Options specific to outgoing interference:

Consider Masking (removed masked Ix)

Interference to a station by the reference station at a
given point is said to be "masked' when interference from
another transmitter already exists at that point. If the
consider masking check box is checked, then masked
interference will not be reported as interference. If it is not
selected, then all interference will be reported, masked or
otherwise.

After choosing the desired parameters, press the "Next"
button to continue.

Second Page - Set Up Station To Be Analyzed



At this point you must set up the reference station to be
considered for outgoing interference. To do so, click the
"Setup Parameters" button, which will bring up a "Transmitter
Properties Form" where you can enter the station's
parameters or load a station out of an FCC database. After
setting up the parameters, you will be returned to this page.
There is one option on this page....

Search FCC Database for Potential Interferers

If this box is checked, the FCC database will be searched
to find stations which might receive interference from the
reference station. If unchecked, you will need to manually
enter each station you wish to consider in the interference
study.

To continue press the "Next" button. If the "Search FCC
Database" box is checked, Probe will find the stations that
the reference station can interfere with before continuing to
the next page.

Third Page - Select Stations to be Considered



If the database was searched, this page will display a list of
the stations that the reference station can interfere with (if
there were no stations found that could receive interference,
the list would be blank). At this point, you can add, remove,
and edit the transmitters to be considered for receiving
interference. Before removing or editing any transmitters,
they must first be selected (click on the station in the list to
select it). When you are finished editing the transmitter list, hit
the "Next" button to continue. At this point, if masking is being
considered, then the program will search the FCC database
for potential masking stations.

Considering Masking

If the study was run with the "Consider Masking" option
turned on, then after clicking "next", you will be prompted to
specify which station types you want to consider for masking
and then review the masking stations. The first window that
appears asks what types of stations to include:



The more stations types you include, the more interference
will be considered as masked (and thus not counted as being
interference within the study). After you specify the station
types to load from the FCC database, the database will be
searched and a second window will appear:



The list of transmitters included in the study will be shown in
the column on the left. The list on the right side of this
window shows all the stations that will be considered as
potential masking stations for the transmitter selected in the
right hand column. Use the "Add", "Edit", and "Remove"
buttons to modify this list.

Fourth Page - Study Creation (Finish)



This is the final page in the wizard. If you wish to go back and
change anything in the interference study, press the "Back"
button. If you are satisfied with the parameters entered, press
the "Finish" button to display the map and begin signal
calculations. There will be a delay while the signal buffers are
set up and the study is created.
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Select the tool you wish to use by clicking the button containing
the icon for the specific tool. The picture above shows the
"Selection arrow" being selected.

Available tools:



Selection Arrow - Select various objects on the map and
move/modify them.

Zoom Tool - Zoom in/out on the map.

Map Information Tool - Displays information about
latitudes/longitudes, signal strength, and elevation at the
cursor.

Text Tool - Add transparent background text to the map.

Text Box Tool - Place a box with text on the map.

Profile Tool - Interactively select a profile to view. 

Pop Up Census Information - Shows the census totals for a
user selected area of the map. 



Arrow Drawing Tool - Draw arrows on the map.

Road Label Tool - Use this to add road labels to the map.

Polygon Tool - This tool can be used to define a polygon on
the map using the mouse (once defined it can be plotted and
population can be calculated within it). 
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The "Selection Arrow" tool can be used to select, move, and
modify items on the map (such as transmitter tokens, text,
text boxes, map scale, and other various moveable and
modifiable objects on the map). To use the "Selection Arrow",
first choose the "Selection Arrow" icon on the map tools
toolbar. Next click on the item you wish to select... when the
item is selected, four square boxes will appear around it. The
following picture shows a transmitter icon before and after
selecting it.



Moving items on the map

When using the selection arrow, the mouse cursor will
change from an arrow to a hand when placed over an
object that can be moved. To move an item, use the
selection arrow to click on the object (using the left mouse
button). While holding down the left mouse button, drag
the object across the screen to where you wish to place it
(the object should now move with the mouse), then let go
of the left mouse button to place it at its final destination.

Modifying items on the map

Some of the objects on the map are modifiable (for
example transmitter tokens, text, and text boxes). To
modify the properties of an item on the map, using the left
mouse button, double click on the item with the selection
arrow. If the object is modifiable a window with properties
for the specific item will pop up. Double clicking on a
transmitter token will bring up the properties for that
transmitter.



Using the selection arrow to access contours

To access the contour setup for a particular transmitter,
first select the transmitter using the selection arrow. Then
right click on the transmitter token. This will make the
contour list for that transmitter appear on the screen. For
help with using contours see: Using Contours.
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Zooming in on a region

To zoom in on a region, first select the zoom tool from the
"Map Tools" toolbar (the icon for this tool looks like a
magnifying glass). Select the region to zoom to by clicking
and holding the left mouse button down and dragging the
mouse to select the rectangle of interest. Once you have
selected the region you wish to zoom to, release the left
mouse button and Probe will automatically redraw the map.

Zooming in on a point



To zoom in on a point on the map select the zoom tool and
then place the magnifying glass cursor over the point you
wish to zoom in on and click the left mouse button once. This
will move that point to the center of the map and decrease
the scale by a factor of 2.

Right clicking with the Zoom Tool

Right clicking on the map with the zoom tool causes the
following menu to pop up:



Choosing "zoom to previous scale" will cause the map to be
redrawn using the scale and center coordinates it had before
the last zoom. The "Move Map Center" function will move the
center of the map to the current cursor location. There are
options here to zoom in/out by a certain scaling factor (for
zooming in: new_scale = current_scale / factor, for zooming
out: new_scale = current_scale * factor). The options at the
bottom of the pop-up menu allow you to set the map's scale
to one that is commonly used.
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To use the "Map Information Tool", first select it from the "Map
Tools" toolbar. Once it is selected, the mouse cursor should look
like a cross hair (or plus). By moving the map information tool
over the map you can get information about various points on
the map. This information shows up in the status bar at the
bottom of the Probe window.

The first two boxes show the latitude and longitude of the point.
The third number is the signal strength of the transmitter
selected in the "Transmitter List" at the cursor point (if signal has
been computed). The fourth box shows the elevation at the point
(since this needs to be loaded out of the database there may be
a slight delay before it comes up, in this case the elevation box
will show "*****" ). The fifth box shows the land cover at the



point.

Right clicking with the map information tool

Right clicking will show the following pop-up menu:

Show Extended Information 

This will make the extended map information window
appear (see below).

Generate Point Report 

Generate a point report.



Add a custom tick mark

Add a custom tick mark to the map.

Move Transmitter

This option is only available for coverage studies. After
choosing this option, the user will be able to select a
transmitter to move to the location where the mouse was
originally right clicked. After moving the transmitter, field
strengths and contours will be recalculated to reflect its
new position.

Extended Information Window 

The "Extended Information Window" can be displayed by
right clicking with the map information tool and then selecting
"Show Extended Information".



The window shows all of the transmitters in the study and
their signal strengths, distance, and bearing at the location of
the map information tool cursor. For interference studies, the
reference transmitter is highlighted in red if the cursor is over
an interference free coverage point. If the cursor is over an
interference point the interfering transmitter(s) signal is
highlighted in red.
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To add a single line of text to the map, first select the Text Tool icon
from the "Map Tools" toolbar. Once selected, the mouse cursor
should change to the text tool icon when the mouse is over the map.
To add text, just place the cursor over the location where you wish to
place the text and click once with the left mouse button. This will
bring up a window that allows you to enter text and set the font for
the text:

Enter the text you want to add to the map in the box. A "shadow" may be



added to the text by clicking the "Display Shadow" box and setting the
shadow color (this can used to make text more readable on a complicated
map). The text can be referenced by its page position or by a
latitude/longitude location. Referencing by lat/lng causes the label to move
to the corresponding position on the map when the map scale or center is
changed, and referencing by page position causes the text to remain in the
same place regardless of the map settings. Check the box labeled "Assign
current options as defaults" and click "OK" to make the settings you are
applying the default settings for new text objects.

To modify and move text once it is on the map use the "Selection Arrow".
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To add multi-line text to the map, first select the text box tool on
the map tools toolbar. Then place the text tool cursor over the
area where you wish to add text. Click once with the left mouse
button and the following window will appear:



Enter the text you wish to show in the large white box. You may
also modify the text box's background color, border color, border
width, and font. When finished click the OK button. The text you
entered should appear on the map surrounded by a box. You
can move or modify this text box using the "Selection arrow"
tool.

Referencing

Setting a text box to be reference by "Page Location" will
cause the text box to stay in the same place on the page
when the map scale or center is changed (use this to place a



note or legend of some sort that doesn't reference a
particular point on the map). Referencing by "Lat/Lng
Position" will cause the text box to move when the map
configuration is changed (use this to specify the location of
something on the map).

Setting the Text Box to Have No Border

If you wish to have a text box appear without a border, but
still have a solid background for the text appear, set the
border width to 0.

Showing the Text Box without the 3D Shadow

To have a text box displayed without the 3D shadow, set the
border width to a negative number. The magnitude of the
number will determine the width of the single line border. For
example, setting the border width to "-2" will yield a text box
with no 3D shadow and a solid line border with a line width of
2.



Check the box labeled "Assign current Properties as Text Box
Default" to make the settings you are applying the default
settings for new text box objects.
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The "Profile Tool is used to specify a starting and ending point for the
profile viewer. To use it, select the profile tool icon on the "Map Tools"
toolbar. Place the "Profile Tool" cursor at the point you wish to be the
beginning of the profile, then click the left mouse button once (if the
point is near a transmitter token the point will be automatically
snapped to the location of the transmitter). Next move the mouse to
where you wish the profile to end, a line will be drawn from the
starting point to the end point. Once the mouse is where you would
like the profile to end click the left mouse button again... this will load
the "Profile Viewer". If you wish to abort using the "Profile Tool" after
you have selected the first point, click the right mouse button.
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To get a quick census report for a rectangular region, first select
the pop up census tool from the "Map Tools" toolbar. Then drag
the pop up census tool cursor to select a rectangular region on
the map. After selecting a region, there will be a small delay
while the census data is gathered from the database, then a
small window will appear with census information.
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The "Polygon Tool" can be used to create a user defined polygon on
the map. To use it, select the tool -- then start clicking with the left
mouse button on the map to define the polygon points. A fine line will
appear going from one point to the next. When you are finished
defining the polygon, click the right mouse button and a heavy line
will connect the first defined point with the last defined point. Once
the polygon is defined the "Selection Arrow" can be used to
interactively modify it (see the "Polygon Object" section of the
manual for information about working with user defined polygons).
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Use the "Display Options" form to change several of the map
properties at once. To access the "Display Options" form,
choose "Display Options" from the Map Menu or click the "Map
Options" button on the Transmitter List Box window.



Signal Display Mode

Depending on whether you are currently viewing an
interference study or a coverage study, the available display
options will change.

Coverage Study

For a coverage study you may plot "Coverage" or
"Highest Signal". When drawing "Coverage" each



transmitter in the study will be drawn using the current
signal cutoff values. Drawing "Highest Signal" will cause
the transmitter color for the transmitter with the highest
signal to appear at each point on the map. You may set
the minimum field strength value to be drawn in the edit
box below the "Highest Signal" radio button (for example,
if you set this to 60 dBu and the field strength at a given
point is less than 60 dBu there will be nothing drawn at
that point). Use the Transmitter List Box to select which
transmitters are allowed to be drawn.

Interference Study

For an interference study, you may plot "Coverage" or
"Interference" on the map. The reason coverage can be
drawn in an interference study is so you can see what
signal strength values are used for the interference
calculations (if desired), however for an interference study
you can only draw the coverage for one station at a time
(which you may select using the "Transmitter List Box").
To select which interferers are displayed use the
"Transmitter List Box".

Signal Drawing Options



The check boxes in the "Signal Drawing Options" box will
allow you to turn the listed special effects on and off.

Additional Options

The buttons in the additional options box will take you to the
following windows:

"Features Button" - Map Features Form

"Signal Button" - Signal Display Options Form

"Settings Button" - Map Settings

"Cutoffs" - Cutoff Settings Form



"Layout" - Page Layout Form
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To access the map colors setup window, choose "Map
Features..." from the "Map" menu (Note: A study must be open
in order to access the "Map" menu). Here is the map color setup
form with a few key items highlighted:



The color setup form displays the names of several items which
may be drawn on the map. The properties for each item are
located on the horizontal line containing the name. After you've
finished setting up the desired map colors, press the "OK" button
to redraw the map using the new colors and line settings.



Color Setup Window Features

Feature TABs

Use the TABs at the top of the window to set up various
advanced plotting features:

General - This is the default page of the map features
window

Roads - Major and Street Level Road Properties

City Names - Extended City Name Properties

Backdrop - Map Backdrop Plotting

Extra Layers - Extra optional data layers

Color Selection Boxes



By clicking on one of these boxes you can select the color
used to draw a feature on the map. The first column of color
selection boxes sets the line or border color for the item. The
second column sets the fill color for the items on the map that
are polygons. In the case of map location names, the color
selection box indicates the font color to use when displaying
them.

On/Off Selection Boxes

Use the On/Off selection boxes to choose whether or not an
item gets displayed. If you check the box, the item will be
displayed on the map.

Extended Properties Buttons ( the "Change" buttons )

Use the extended properties buttons to set some of the extra
properties for displaying lines and polygons, such as
border/line width and line style. See "Extended Properties for
Lines and Polygons" for more information on extended



properties.

Relative Size Edit Box

The relative size edit box allows you to set a relative size for
the US County Names. When drawing the map, Probe sets
the size of the county names based on the scale of the map.
However, if you would like the names to appear at a different
size, change the relative size edit box. The larger the relative
size, the larger the names will be.

Load/Save Map Color Schemes

Use these buttons to save the current color setup as a color
scheme or load a previously saved color scheme.

Grid Lines and Tick Marks



Clicking the "Tick Mark Settings" button will bring up the Tick
Mark Settings form where the grid line and tick mark
attributes can be specified.
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To change the extended properties for lines and polygons to be
drawn on the map, press the "Change" button for the type of item
you would like to change on the Map Features Window. Here is an
example extended properties form:



You can set the border and fill color by clicking on the color selection
boxes. You can also set the border width and border style. The large box
next to the border width selection shows a preview of what the line will
look like. Use the "Plot on map" check box to select whether the particular
line or polygon is drawn. Use the "Fill using fill color" check box to select
whether polygons are filled (if this is unchecked, only the boundary of the
polygon will be drawn). Press the "Accept" button to change the current
item's properties (press "Cancel" to abort).
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The "Tick Mark Settings" form is where the properties of tick
marks and grid lines can be set. This window can be accessed
from the "Map Features" window.



Visibility

The type of latitude/longitude reference marks can be
selected as Tick Marks, Grid Lines, or None. Selecting none
will cause the map to have no grid lines or tick marks.

Spacing



There are two ways that reference mark spacing can be set.
Probe will automatically choose a spacing based on the
map's scale if you choose "Automatically Space Ticks". If
"Fixed Spacing" is defined, the user may select the reference
mark spacing using the boxes labeled "Mark off Every".

Settings

The settings box allows the user to set the line thickness, line
color, and whether or not labels will appear with tick marks. If
the "Labels With Ticks" box is checked, Probe will print the
latitude/longitude coordinates at reference mark
intersections. When labels are printed, the northern-most
visible ticks will have the longitude displayed, and the
eastern-most ticks will have the latitude displayed.
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The road drawing properties are configured using the Map
Features Window.



Major Roads

Probe has two types of road databases. The "Global Road
Database" has roads for the entire world, however there are
no road names or labels contained within this database.



The "Enhanced US Road Database" * contains roads for the
US and its territories in three categories: Interstate (or divided
highways), US highways, and state highways. For each type
of road the user can specify a map scale cutoff at which the
type of road will be displayed. Clicking the "Properties" button
for each road type will display the following properties
window:

Here a line color and a border color and line width can be
specified.

Street Level



Street level mapping is currently only available for the US. A
map scale can be set at which street level roads and street
level road names will be displayed. The street name color can
be specified and the street level line color and width can be
specified.
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The city name display properties can be modified on the "City
Names" page of the "Map Features" window.



Different properties can be set for large and small cities. For each city type,
a border color and a font can be defined (use the City Font buttons to set the
size and typeface for each city type). A circle or square marker can be
drawn at the city location with a specified foreground color and border
color (check "show a border around markers" to make the border visible).
The "Background Type" specifies the type of background used for the city
names border. A population cutoff can be set to determine which cities are
plotted as "large cities" and which are "small cities". Check the "Do not
show cities with population less than" check box in order to limit the cities
displayed based on the specified population cutoff.

 



 



 

 

 

Backdrop Plotting
Previous

Top

Next

 

Probe has the ability to display certain data items as a backdrop
to the map. The backdrop is configured via the "Map Features"
window shown below.



The drop down list box is used to select the type of backdrop
you wish to display. The contents of the "Properties" section of
this window will change depending on what type of backdrop the
user has selected. Use the "Modify Properties" button to change
the display properties of the various backdrop types.

Backdrop Types



Census Scattergram 

The census scattergram backdrop shows the locations
and populations of the census blocks. The "Modify
Properties" button allows the user to set the color and
scale cutoff used in determining when the block
populations are displayed.



You can also select the database to be used and, if
desired, a subset of the population to plot. Note that when
the scale is greater than the specified cutoff - a 'plus mark'
is shown for all points that contain any of the selected
subset population (and when zoomed in the number
displayed reflects the total number of that subset).

Census Density 

The census density plot allows the user to select a set of
colors to represent various census density values.

Census density is calculated by creating a grid of cells
and then counting the populations of each cell and



dividing by the area of the cell. The "Base Density
Spacing" value indicates the size of the side of each cell
in the grid. Click on the graphic that shows the density
color coding to modify it. Here you can also select the
population database and a specific category within the
dataset to use for density calculations.

Basic Terrain Plot 

The basic terrain plot backdrop will display a "color coded"
plot of the terrain on the map. The user can select the
color for the minimum, mid, and maximum elevation
(when displayed Probe will interpolate between the colors
to generate the terrain plot).

Enhanced Terrain Plot 

The enhanced terrain plot calculates a grid of elevation
and allows the user to define cutoffs to use in plotting the
terrain values.



Click on the colors graphic to edit the colors and elevation
ranges.

Land Cover Plot 

The land cover plot shows a graphical representation of
the land cover on the map. The colors used to represent
each type of land cover can be set using the "Modify
Properties" button .



Click on the color for the given land cover type to modify it.
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Extra layers can be added to the map using the "Extra Layers" TAB
of the Map Features Window.



Layers that are shown on the "Plot" list on the left hand side of the window
will be drawn on the map. Layers that are in the column on the right are
layers that are available but not plotted. To move a layer from one list to the
other, select it in the list and then click the red arrow button pointing toward
the list to which you want to move it. Select a station in the plot list and
click the edit button to edit the settings for the selected layer. Note - the
available layers will be site specific.

Available Layers



FCC ASR Towers (Optional)

Plot the FCC Antenna Structure Registration database
towers on the map.

Tower locations can be configured to show the AMSL tower
height and the tower coordinates at user defined zoom levels
(scales).

Zip Code Point Location (Optional)

This plots the zip code point locations on the map (the zip
code number will be centered on the location).



ZCTA Boundaries (Optional)

This plots the Zip Code Tabulation Area (ZCTA) boundaries
on the map.

The boundaries will always be plotted. To show labels on the
map, check the box labeled "Show labels with ZCTA
boundaries". Click the line properties preview graphic to set
the line thickness, color, and style.

Import Data Layer 

This layer can be used to import new layers into the program.
See Importing Map Layers for more information.
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To set the maps center latitude, center longitude, scale, and
projection - choose "Map Settings" from the "Map Menu". The
following window will appear:

Latitude and Longitude

Enter the latitude and longitude in the boxes labeled
accordingly. This will set the center of the map to the
specified coordinates. For help with valid latitude/longitude



entry formats see "Entering Latitudes and Longitudes".

Scale

Enter the desired map scale in the edit box labeled "Scale".
The scale is entered as a single number (it may contain
commas, however they are not required). In the example the
map scale is 1:1,500,000 .

V-Soft Reference Buttons

Use these buttons to retrieve or save the current coordinates
to/from the V-Soft reference file.

Projection

Use the radio buttons on the right side of the window to
select the map projection to be used. Note that the projection
listed as "Cylindrical" is also know as "No Projection".
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The signal drawing options can be accessed by choosing
"Signal Display Options" from the "Map" menu, or from the
"Display Options" form.



General Options

Plot Signal Transparently

If checked, the signal colors are averaged with the
background colors to enable the user to see objects
below the signal layer.

Plot City Polygons below the signal layer

Normally city polygons are plotted above the signal layer
and cover the signal. Check this box to plot the city
polygons under the signal layer.



Draw Signal over water

This switch determines whether or not signal is plotted
over water (in this case "water" refers to oceans or other
large bodies of water that are colored the same color as
the oceans).

Plot KWX error points

The Longley/Rice propagation model reports what are
known as KWX errors when it encounters situations
where the model may not be completely accurate. This
allows the user to plot the locations of these KWX error
points.

Interference

Plot Interference Transparently

If checked, the interference colors are averaged with the
background colors to enable the user to see objects
below the interference layer.



Show Coverage and interference simultaneously

This will cause interference to be plotted on top of
coverage for interference studies.

Highlight terrain blocked points

This feature only works with OET 69 interference studies.
This allows the user to flag the points in the study where
the desired station's field strength falls below the required
"threshold for reception".
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Probe is designed to be a full WYSIWYG (What You See Is
What You Get) interface, allowing you to see things on the
screen exactly as they will appear on the printout. The page
layout form allows you to set up the margins used and the page
size. The page layout form can be accessed by choosing
"Layout" from the Map Menu.



Page Size

You should set the height and width (in inches) to match the
size of your paper. You may also choose whether you want to
print in portrait or landscape mode. Clicking the "Use Printer
Settings" will set up the page size to correspond with the
current default printer settings.

Margins



By setting the margins you can set where the map will be
displayed on the page. The preview window (on the right) will
show the portion of the page where the map will be
displayed.

Display Mode

Probe supports two modes, "Publishing Mode" and "Standard
Mode". When in "Publishing Mode", Probe uses the page and
margin settings to give a WYSIWYG representation of the
current study. When in "Standard Mode", Probe will not use
the page size and margin settings. Instead it will display a
fixed size bitmap containing the map and any objects you
may have added using the "Add To Map" feature. You may
select the display mode by selecting the corresponding radio
button. When you switch to "Standard Mode", the margin and
page settings will disappear and a box which lets you select
the resolution of the bitmap will appear.

Setup Printer



Click the "Setup Printer" button to configure the current
printer settings.

When you have finished setting up the layout, click the "OK"
button (click "Cancel" to abort).

 

 



 

 

 

Defining Cutoffs
Previous

Top

Next

 

To change the cutoffs used when drawing signal values on the
map choose "Signal Cutoffs/Colors" from the Map Menu. The
following window will appear:



The box on the right shows the current cutoff setup (the current
selected cutoff is highlighted in blue). To add a new cutoff, press
the "Add" button. To modify the cutoff, highlight the cutoff you
wish to change and click the "Change" button. You can select a
cutoff in several different ways, using the U and D keys to move
"Up and Down", you can use the N and P keys (for Previous and
Next), or you can click on the cutoff using the mouse. Use the
save and load buttons to save the current cutoff set to a file and
load a previously saved cutoff set. When you are finished editing
the cutoff set, click the "OK" button (after closing this window
you will need to press the "Redraw" button on the main window
to redraw the map with the new signal cutoff and color values).
Check the "Save current cutoffs as defaults" to have this cutoff
set be used by default when creating new studies.
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The "Signal Coloration Mode" pop out style menu on the Map menu can be used to set the
program to use the TV band based cutoffs. In this mode, the user can define different cutoff
sets for each TV band. When you edit the cutoffs in this mode, the following window appears:



The legend that is displayed on the map can be defined by clicking the "Edit
Legend" button. A report can be generated that uses these cutoffs by
selecting "TV Band Based Population" from the Report menu.
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The "Special Effects" menu is located on the "Map" menu. Each
special effect can be turned on/off by clicking on the menu item
for it (if it is turned on, a check will appear next to the name on
the menu). After setting a special effect, you must press the
"Redraw" button.

Interpolate Signal Values

This causes Probe to use four-point interpolation to find the
signal values at each point on the map. This effect makes the
signal appear much less blocky, and more like the real world.



Gradient Signal Shading 

This causes the signal to be drawn in a more revealing way
than by drawing cutoff ranges. Gradient shading will
interpolate the color values for the defined cutoffs. For
example, let's say you have two cutoffs defined -- one at 100
dBu (which is colored yellow) and one at 80 dBu (which is
colored blue). Without gradient shading, every point where
the signal value is between 80 and 100 will be colored solid
blue. With gradient shading, points will appear more blue the
closer their values are to 80 dBu and more yellow the closer
they are to 100 dBu. Therefore if the signal at a point is 90
dBu it will appear to be "bluish yellow" or "yellow with a hint
of blue".
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Probe supports three different signal drawing modes, however
the availability of these drawing modes depends on what type of
study (either interference or coverage) is being performed. You
can set the drawing mode by using the pop-out style menu on
the Map Menu, or select it using the Display Options Form.

Coverage Study Drawing Modes

When a coverage study is loaded, there are two drawing
modes available:

Coverage



In this mode Probe will draw the field strength values
of each station in the study using the defined cutoffs
and special effects. For studies with more than one
transmitter, the transmitter which has the highest field
strength value at a given point will have its signal
value plotted.

Highest Signal

In this mode Probe will plot the color associated with
the transmitter which has the highest field strength
value at each point on the map (a transmitter's color
can be assigned using the "Transmitter List Box"). You
can also set the minimum field strength value at which
a transmitter's color is plotted using the "Display
Options" form.

Interference Study Drawing Modes

When an interference study is loaded, there are two
drawing modes available:



Interference

This mode will show areas where interference occurs
using the color associated with the interfering station
(for an outgoing interference study the color of the
station receiving the interference will be plotted). You
can select the transmitters to be displayed using the
"Transmitter List Box".

Coverage

In this mode you can plot the field strength values for
one station in the interference study (you may select
this station using the "Transmitter List Box"). For
stations in the interference study, only signal which
has been calculated for the station will be drawn.
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The "Map Menu" contains a pop-out style menu labeled
"Commands". This menu has several options that cause the program
to perform a specific function with respect to the map.

Force Map Redraw

Forces the map to be redrawn (this is the same functionality as
the "Redraw" button in the transmitter list section of the main
window).

Hide All Contours



Hides all contours that have been added to the study (this turns
off the visibility of all contours in the study).

Show All Contours

Shows all contours that have been added to the study (this turns
on the visibility of all contours in the study).

Interference Study Color Reset

This function is only available for interference studies. It resets
the colors associated with each transmitter so that every
transmitter that actually causes some interference is set to a
color, and stations that do not cause interference have their
associated color set to white. This allows the user to quickly
determine which stations in the transmitter list cause
interference and which ones don't. Note - if something in the
study is changed that causes interference to be re-calculated
this command should be used again (ie. this will not
automatically be refreshed).
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Use the "Import Data Layer" feature on the "Extra Layers" TAB of the
Map Features window to add new data layers to the map.



Currently Probe supports importing data layers that are in MIF (Map Info)
format. Once layers are imported, the red up and down arrows can be used
to set the plot order (select the layer you wish to change and use the 'up'
button to move it up in the plot order, items shown at the beginning of the
list are plotted on 'the bottom'). Select a layer and click the "Edit" button to
edit the layer's plot properties.

Editing Import Layer Properties



The layer name can be edited by changing the text in the box.
Click on the line preview to edit the line style properties. If the
data imported was polygon data, the polygons will be filled with
the specified color if "Fill Polygons" is checked.

Importing MIF Files
When you click the "Import MIF File" button, the following
window will appear:



Use the "Browse" button to find the file you wish to import. There
are two options for how you can import the map data objects
within the file. If all of the objects are the same thing (for
example, if all of the objects in the file are county lines - or some
other data type where you would wish to set the same plotting
properties for all of them at once) then choose "Group all objects
of the same type into one layer". If the file contains different
object types (or objects where you want to be able to set the plot
properties independently for each one) then choose "Create a
new layer for each type of object in the file".
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The program allows the use of Page Layout Templates for saving
and restoring a given page setup including labels and other objects
added to the map. The basic idea is that you can interactively setup
a page to appear how you would like other maps to appear, and then
save this configuration to be loaded into a different study at a later
time. This way you can prepare the labels (transmitter info, study
data, user logos, etc), and quickly apply the same settings to another
map.

To save and load a map template, use the save and load function located on
the "Page Layout Templates" section of the Map menu.

What is saved to a template:



The Page Layout (page orientation and margins)

Non-study specific items added to the map (text boxes, text
labels, user logos, map scale)

What is not saved to a template:

Study Specific Items (things like arrows and user defined
polygons)

Map Features Settings (boundary and other map layer
settings)

When preparing a page to be saved as a template, keep in mind that
you only want to have generic information located on the map that
can be applied to any situation that you plan to use the template for.
You should not have any study specific information on the map that
doesn't use variables for its definition.
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Text labels and text box items that have been added to the map can
reference internal study variables to generate their content. This
allows information on the map to be automatically updated when the
study is changed (for example - modifying a transmitter). To
reference a variable, place the variable's name inside of a set of two
straight brackets.

Example:

[[VariableName]]

When the label is rendered to the map, all items enclosed in the
double brackets will be replaced by its variable counterpart. You can
access information about specific transmitters by specifying



"Transmitter(#)." with the number of the transmitter from the
transmitter list inside of the brackets (starting with #1). So to
reference the call letters to the 3rd transmitter in the list, use the
following:

[[Transmitter(3).CallSign]]

As a final example, say you wanted a text box to show the call letters
of the first station of the study and the current date, you would enter:

Station: [[Transmitter(1).CallSign]]

Map Printed on: [[TodaysDate]]

If the first station in the transmitter list was KXYZ and the current
date was Dec 1, 2003 -- then this would appear on the map as:

Station: KXYZ



Map Printed on: 12/1/2003
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There are several variables that reference study information:

CompanyName - Shows the company name specified in the program study
defaults.

StandardStudyInformation - This multi line variable returns the standard
study information block that contains various information relevant to the
study.

StudyDate - Shows the date that the study was created.



TodaysDate - Shows the current data according to the computer's internal
clock.
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The following transmitter specific variable names can be accessed.
Note that you must reference these using a preceding
"Transmitter(#)." statement.

For Example:

To display the channel of the first transmitter in the transmitter
list, you would use the following:

[[Transmitter(1).Channel]]



Variables:

CallSign - The transmitter's call letters.

FileNumber - The transmitter's file number.

ERP_kw - The transmitter's ERP in kilowatts.

EIRP_kw - The transmitter's EIRP in kilowatts.

Channel - The transmitter's channel number.

Latitude - The latitude of the station.

Longitude - The longitude of the station.



Frequency_MHz - The frequency in megahertz.

Height_AMSL_m - The AMSL height of the transmitter (in meters).

Base_Elev_m - The base elevation of the transmitter (in meters).

HAAT_m - The transmitter's HAAT.

Class - Station class.

City - City of license.

State - State abbreviation.

HPAT_Status - The status of the horizontal pattern. Displays "Directional"
for direction stations and "Omni" for omni-directional stations.



VPAT_YesNo - Displays the definition status of a vertical pattern. Shows
either "Yes" or "No".

All_VPAT_Info - This multi-line variable returns a summary of the vertical
patterns status. If electrical or mechanical beam tilt exists, this information
is also shown.

PropagationInfo - This multi-line variable shows the propagation model
and associated variables.
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Probe allows you to add several different objects to the map. To
add an object to the map, choose the object you wish to add
from the "Add to Map" pop-out style menu on the Map Menu.
Most of the objects which are added to the map will initially be
displayed in the upper left hand corner of the map (with the
exception of the scale which is shown at the bottom right of the
map). Once added, these objects can be moved or edited using
the selection arrow.

Available objects:

Scale



The map scale shows a scale for the current map (and
the current map scale in a 1:XXXXX fashion). As you
zoom in and out (or change the map scale) the scale
object will change size to accommodate for the changing
map scale.

Transmitter Info

When you add transmitter information to the map, you will
be prompted for which transmitter's information to display
(you will also be able to specify whether or not to show
propagation information with the transmitter's information).
This information will be added using the default
transmitter information template.

Signal Cutoffs

A signal cutoff object will show the signal level cutoffs
being used in a study.



City Name

This enables you to add a city name to be displayed on
the map, see "Adding City Names" for more information.

Transmitter List

The transmitter list object will display all of the
transmitters in the study along with associated colors
(these are the colors used to draw interference and
highest signal).

Study Information

The study information object will display a brief summary
of the parameters of the study that were specified in the
wizard.



Backdrop Info

The backdrop info will display a "legend" describing the
current backdrop parameters (see "Probe Backdrops" for
more information).

User Defined Logo 

A logo or graphic can be loaded from a graphics file and
added to the map (see "User Defined Logo's" for more
information).

Custom Tick Mark

A user definable tick mark can be added to the map to
mark a location or point of interest.

Land Cover Info



If land cover was used in signal calculation, the land
cover info object will display a list of the land cover
attenuation values used in signal calculation.

Color Legend 

A color legend can be used to place a label on the map
that looks like the one used for signal field strength but
can contain user defined text.

Interference Transmitter List 

For interference studies -- this creates a color legend
similar to the transmitter list that includes only stations
that actually cause interference.
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When using the US enhanced road database, road labels will appear
on the map. Road labels can also be added using the road label map
tool. The graphic that appears depends on the type of road:
Interstate, US Highway, or State Highway. The graphic on the right
side of the window will display a preview of the current road label
configuration.
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The arrow drawing tool is used to draw arrows on the map. To
use it, select the arrow drawing tool icon from the "Map Tools"
toolbar. To draw an arrow, place the cursor at the location on the
map where you would like the head of the arrow to be and click
the left mouse button. Then move the cursor to where you would
like the tail of the arrow to end and click the left mouse button
again. Once an arrow has been added to the map its properties
can be edited. To change an arrow's properties, select the arrow
using the "Selection Tool". Then double click on the selected
arrow to open the arrow properties window.



In the arrow properties window, you can set the line width and
color of the arrow. You can also set whether or not a point is
drawn at the head of the arrow (if the "show point at the end of
this arrow box" is unchecked the arrow will be drawn as a line).
The arrow head can be filled by checking the box labeled "Fill
the head of the arrow". You can adjust the size of the arrow
head by setting the "Head Size". There are three options for the
width of the arrow head: Small, Medium, and Large. Check the
box labeled "Make these settings defaults" to make the settings
specified when the "OK" button is clicked the default settings for
new arrows.
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If you wish to add a city name to the map, choose "City Name"
from the "Add to Map" pop-out menu on the Map Menu.



The list shows the names which have been added to the map. If
you know the coordinates of a city that you would like to add,
click the "Add" button. To edit the coordinates of a city that has
already been added, select the city's name in the list and click
the "Edit" button. To remove a city which you have added to the
map, click "Delete". If you do not know the coordinates of the
city you wish to add, you may search Probe's comprehensive
city name database by clicking the "US Name Search" or
"International Name Search" buttons.

When you are finished adding cities to the map, click the "Close"
button.

Searching US Name Database



As you type in the city's name, a list will be displayed in the box
below containing matches for that name. To add a city from the
database, select it from the list in the bottom box and click the
"Add to List" button.

Searching the International Name Database

This works the same as US name searching, however you must
specify the country you would like to search in the drop down list
box at the top of the window.

A note about how Probe plots names:



Probe plots city names on the map in such a way that
overlapping will not occur. For example if two cities are
adjacent to each other (in such a way that when they are
displayed the names will overlap), the name of the city with
larger population will appear and the other will not be drawn.
Any city names you have added to the map will take
precedence over other names and will always be plotted
(unless you add two cities which overlap, in which case the
first one entered will be drawn).
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A user defined tick mark can be added to the map using the Map
Information Tool or from the Map menu by choosing "Add to
map" and then selecting "Custom Tick Mark".

Here the latitude and longitude can be entered, read from the V-
Soft reference file, or found by searching the tiger street level
database for a US street address. The tick mark size and color
can be adjusted, and a label can be added to the tick mark. Use



the position drop down list boxes to select the position that the
label appears at with respect to the tick mark. Check the "Make
these settings default" to make the current settings the defaults
for new tick marks.
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A user defined logo or graphic can be added to the map from the
"Map" menu by choosing "Add to Map" and then "User Defined



Logo".

Use the "Load" button to load a graphic from a file. The height
and width can be entered in inches. These values reflect the size
of the image on the screen and on the printer. If the box labeled
"Maintain Original Aspect Ratio" is checked - then when changing
the height or width the one that is not changed by the user will be
automatically modified to match the aspect ratio of the orginal
graphic. Note that in general the logo image will need to be
scaled down to be plotted appropriately on the screen, however it
will usually be stretched to fit on the printer. In many cases the
image will not look good on the screen but will be fine on the
printout.

The border width and border color can be set in this window,
although they will not be reflected in the preview on the left. Click
the "Make this logo the default" and press "OK" in order to save
the current logo as the default (doing this will cause the logo to
be automatically loaded the next time one is "Added to the Map").
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Select "Color Legend" from the "Add to Map" pop-out style menu
located on the "Map" menu. User defined color legends can be used
to place a label on the map that has color associated with user
configurable text.



Use the "Add New Label" button to insert another item at the end of the list.
The color and text associated with the label selected in the list can be edited
on the right hand side of the window. Use the "Move Up" and "Move
Down" buttons to change the order of the selected item in the list.
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The polygon map tool can be used to add new user defined
polygons to the map. Once these polygons are defined, they can be
interactively manipulated. Use the selection tool to select a polygon
by clicking on one of its vertexes, this will cause the polygon to
become highlighted having "squares" appear on all of its vertices:



Once the polygon is selected, you can move individual points around by
clicking (and holding) the left mouse button while dragging the point.
Double clicking on one of the vertices will show the polygon properties
window:

Here you can select the type of polygon. If the type is set to "Line" then the
first and last point in the polygon will not be automatically "closed". Click



on the pen style preview to change the line width and style settings. The
button labeled "Edit Polygon Points" will open the polygon editor.

The insert and remove buttons can be used to modify the individual points
of the polygon. When "Insert Before" and "Insert After" are used, a new
point is inserted relative to the position of the selected point. The default
value for inserted points will be the average of the point directly preceding
the inserted point and the point directly after it (so the new point will lie
exactly in between). The "Export" and "Import" buttons can be used to save
the polygon to a simple ASCII file. The button labeled "Population Report"



will generate a report of the population contained within the polygon with
racial and county breakdown.

Tip: When editing the polygon interactively on the map, if you right click
on one of the vertices the polygon point editing window will appear with
the vertex that was clicked on as the selected vertex. This provides an easy
way to add a new point that is next to one of the points that you see defined
on the map -- simply click the "Insert After" button and press OK and you
will see the 'new' point has been added.

This image shows the polygon after right clicking on the selected point in
the graphic above and using the "Insert After" feature:

Note that the new point is directly between the two existing points.
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Probe allows the user to define any number of contours for any
transmitter in a study (these contours are drawn on the map as a
solid curved line). Contours for a given transmitter can be accessed
in several ways:

1. Use the selection arrow to select a transmitter token, and then
right click on the transmitter token.

2. Choose "Transmitters" from the View menu, then highlight the
call letters for the desired station and click the "Curves" button.



3. Right click on a transmitter's call letters in the transmitter list
box.

Each transmitter has its own list of contours associated with it. After
accessing the contour list using one of the previously mentioned
methods, the following window will appear:

Each contour has a check box next to it - this sets the visibility of the
contour on the map (uncheck it to have the contour not be plotted on the
map). After selecting a contour, the following operations can be performed
(click the "Add" button to add a new curve):



Edit
Editing the contour will bring up the same form that was used to
add the contour to the study. There you can set the properties
for the selected contour.

Delete
Removes the contour from the study.

Report
Distance To Contour Table

This will create a table showing the "distance to contour"
values.



The user may select how many radials to show in the report,
and add addition azimuths to include those that may not be
on standard radials. Check the "Show HAAT in Report"
option to show HAAT values for each radial.

Population Report

Creates a population report for the selected contour. This
report will include: total population within the contour, total
area within the contour, and a county by county breakdown of
the population (with racial breakdown).

Zip Code Report (Optional)



A zip code report generates a list of all of the zip code
centroid points that fall within the contour.

Clicking the close button on this form will close the window and
cause any new/edited contours to be drawn on the map.

Adding/Editing Contours

To add a new contour to the current transmitter, click the "Add"
button. The following form will appear:



The contour editing window is set up as a series of tab sheets
which contain the various options for each contour. The
"General" tab contains the settings used for drawing, the "Calc
Area" tab contains the settings for the number of points and arc
calculation, the "Terrain" tab shows the terrain database
configuration used for this contour, and the fourth tab will change
depending on what type of contour is being edited. At the top of
this window, there is a drop down list box where you can change
the contour type, available types are: FCC Contour, FMPTP,
FMPTP2, Circle, Import, and calculated signal contours. An
Import contour is used for importing and displaying contours
created by other programs. Probe currently supports importing
DTC and PLT files. A calculated signal contour uses the signal
which Probe has already calculated for the transmitter to
generate a contour. Calculated signal contours can be found for
the first occurrence of a certain field strength along each radial,
the last occurrence, or the mean (which is the average of the
distance to the first occurrence and the distance to the last
occurrence). When "OK" is pressed, Probe will perform any



necessary calculations for the contour and return the user to the
contour list form, where pressing the close button will plot any
new/edited curves on the map.

The General Tab

Clicking on the "General" tab will display the general contour
display options. Here you can set the color, line width, choose
whether or not cardinal radials are drawn (also which ones are
drawn), and choose whether or not to have Probe automatically
show a label with the contour on the map.



Use the "From TX" button assign the color that is associated
with the current transmitter shown in the transmitter list box of
the main window.

The Calc Area Tab

When calculating an entire contour, the number of points
(radials) to be calculated can be set to 8, 12, 36, 72, 180, or 360.
Probe also supports the calculation of an arc instead of the



entire contour (this is useful when using FMPTP because of the
large amount of time PTP contours take to calculate). You can
specify the start and stop bearing for calculation by using the
drop down list boxes. When an arc is calculated, probe
calculates one radial per degree.

The Terrain Tab

The Terrain tab shows the terrain configuration used for
calculating this contour. This defaults to the terrain setup
specified for the study, but can be changed independently for
each contour. Use the "Edit" button to change the terrain
configuration.
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Probe currently supports the following propagation models:

Longley/Rice - Also known as ITM (Irregular Terrain Model)

FCC Model - This is the same propagation model that is used
in determining standard FCC contours.

TIREM - Terrain Integrated Rough Earth Model (Optional)



Line of Sight / Shadow - Indicates which cells have line of
sight with the transmitter

FMPTP - The original implementation of the propagation
model used in the calculation of the proposed FMPTP
Contours. This is also known as the FM point-to-point model.

FMPTPv2 - The latest FCC propagation model used for
FMPTP Contours

Okumura/Hata - Computer implementation of the Okumura
propagation model

COST-231-Hata - Computer implementation of the COST-
231 propagation model

The propagation model used for signal calculations for a
specific transmitter can be selected on the Transmitter
Properties Form.
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The Longley/Rice propagation model is also know as the
Irregular Terrain Model (ITM). Probe uses version 1.2.2 of the
Irregular Terrain Model. The Longley/Rice model is intended for
use with frequencies from 20 to 20,000 MHz, and distances less
than 2,000 km.

Model Inputs

Conductivity

This is the conductivity of the ground over which the
signal propagates (measured in Siemens per Meter). See



the table of suggested values for different types of ground
(located at the end of this chapter).

Dielectric Constant

The dielectric constant is the relative ground permittivity.
See the table of suggested values for different types of
ground (located at the end of this chapter).

Refractivity

This is the atmospheric refractivity, measured in N-Units
(parts per million). See the table of suggested refractivity
values for different climate zones.

Climate Zone

The climate zone can be one of the following:



None

Equatorial

Continental Subtropical

Maritime Subtropical

Desert

Continental Temperate ( this is the most commonly
used )

Maritime Temperate Overland

Maritime Temperate Over sea



Antenna Polarization

This is the polarization of the transmitting and receiving
antennas. Longley/Rice supports horizontal and vertical
polarization.

Receiver Height

This is the receiver height above ground (in meters).

Receiver Gain

This is the receiver gain in dB.

Time Variability



This is the time variability expressed as a percentage
(between 0 and 100). When considering an analog
station's coverage (NTSC and FM), a time variability of
50% is usually used. For digital stations (DTV), a time
variability of 90% is generally used. For interference
calculations, a time variability of 10% is standard for
stations causing interference.

Situation Variability

This is the situation variability expressed as a percentage
(between 0 and 100). Generally a 50% situation variability
is considered.

Urban Clutter Factor

The urban clutter factor is an additional loss factor
determined by A.G. Longley to make the Longley/Rice
model results resemble the results for the Okumura
propagation model (for use in urban areas).



LR Mode

There are two modes for the Longley/Rice propagation
model, Broadcast and Individual. In general the broadcast
mode should be used for signal calculations. The Satellite
Home Viewers Act required the use of Longley/Rice in
"individual" mode.
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The FCC Propagation model is the same model used to
determine FCC contours.

Model Inputs

Time Variability

This is the time variability expressed as a percentage
(between 0 and 100). When considering an analog
stations coverage (NTSC and FM), a time variability of
50% is usually used. For digital stations (DTV), a time
variability of 90% is generally used. For interference
calculations, a time variability of 10% is standard.



Location Variability

This is the situation variability expressed as a percentage
(between 0 and 100). Generally a 50% location variability
is considered.
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The Terrain-Integrated Rough-Earth Model (TIREM) system is
designed to compute transmission loss for transmitters of
frequencies between 20 and 20,000 MHz.

Model Inputs

Conductivity

This is the conductivity of the ground over which the
signal propagates (measured in Siemens per Meter). See
the table of suggested values for different types of ground.



Dielectric Constant

The dielectric constant is the relative ground permittivity.
See the table of suggested values for different types of
ground.

Refractivity

This is the atmospheric refractivity, measured in N-Units
(parts per million). See the table of suggested refractivity
values for different climate zones.

Humidity

This is the absolute humidity of the atmosphere (in grams
per cubic meter). The humidity is usually set to 10.



Climate Zone

The climate zone can be one of the following:

None ( if you choose this, TIREM will not perform
power fading calculations )

Equatorial

Continental Subtropical

Maritime Subtropical

Desert

Continental Temperate ( this is the most commonly
used )



Maritime Temperate Overland

Maritime Temperate Over sea

Antenna Polarization

This is the polarization of the transmitting and receiving
antennas. TIREM supports horizontal and vertical
polarization.

Receiver Height

This is the receiver height above ground (in meters).

Time Variability



This is the time variability used in TIREM's power fading
calculations expressed as a percentage (between 0 and
100). If the climate is selected as "None", TIREM will not
perform power fading calculations thus this value will not
be used.
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The line of sight propagation model checks to see if the
transmitter has a line of sight with the receiver. If it does, then
the points signal value is set to 100 dBu. If there is not line of
sight between the transmitter and receiver, the points signal
value is set to 60 dBu. The user must set up colors to represent
line of sight signals and shadowing.

Model Inputs

Receiver Height



This is the receiver height above ground (in meters).

Earth's Curvature

This is the Earth's curvature constant ( "K" constant )
used in calculation of the profile, it is usually set to 1.33.
To use flat earth (no curvature) set this value to 0.
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This is an implementation of the propagation model used in
computing the FCC's proposed Point-to-Point Contour
Prediction Method for FM broadcast stations. Probe allows
the use of the "propagation model" part of the method as a
stand alone propagation calculation model (like
Longley/Rice, the field strength is calculated using the terrain
for each point in the specified area of calculation). This
propagation model requires no inputs beyond the reference
station's parameters. In order to plot FMPTP contours, see
Using Contours.

Differences from the FCC's current implementations of
FMPTP



The FCC specifies that the FMPTP model is to use 30
Second terrain with 0.25 mile (about 0.4 km) spacing
along azimuths. For improved accuracy, Probe can use 3
second terrain with 0.1 km spacing along azimuths.

For more information on FMPTP see:

http://www.fcc.gov/oet/fm/ptp
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This is an implementation of the FCC's latest propagation
model to be used in computing the FCC's proposed Point-to-
Point Contour Prediction Method for FM broadcast stations.
Probe allows the use of the "propagation model" part of the
method as a stand alone propagation calculation model (like
Longley/Rice, the field strength is calculated using the terrain
for each point in the specified area of calculation). This
propagation model requires no inputs beyond the reference
station's parameters. In order to plot FMPTPv2 contours, see
Using Contours.

For more information on FMPTP see:

http://www.fcc.gov/oet/fm/ptp
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The Okumura propagation model that Probe uses is the
Okumura/Hata/Davidson implementation. Hata developed a set
of equations that provide Okumura model predictions for
computer use. The Davidson correction factors extend the
frequency and base antenna height range.

Model Inputs

Receiver Height

This is the receiver height above ground.



Environment

The Okumura propagation model supports five different
environment types. These are Urban, Sub Urban, Quasi
Open, Open, and user defined correction factor.

User Defined Correction Factor

The Okumura propagation model works in such a way
that the maximum (Urban) attenuation is calculated and
then a correction factor is applied to generate the other
environment attenuations. Probe allows the user to enter
a custom correction factor instead of using one of the
model defined corrections. In general this correction factor
should be a "negative" number (dB attenuation).

Model Limits



Frequency Range: 30 - 1500 MHz

Transmitter Height: 20 - 2500 m

Maximum Distance: 300 km
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Probe implements the COST-231/Hata version of the COST-231
propagation model. This model uses the HAAT along each radial
to determine the attenuation based the following equation:

Path Loss (dB) = 46.3 + 33.9*log( F ) - 13.82*log( H )

+ [44.9 - 6.55*log( H )]*log( D ) + C

where



F = Frequency (MHz)

D = Distance between base station and receiver (km)

H = HAAT in the direction of the receiver (m)

C = Environmental-correction factor (dB)

The Hata correction for receiver height and frequency is then
applied to calculate the final attenuation.

Model Inputs

Receiver Height

This is the receiver height above ground.



Environment

The COST-231 propagation model supports five different
environment types. These are Dense Urban (-0dB), Urban
(-5dB), Suburban (-10dB), Rural (-17dB), and user
defined correction factor.

User Defined Correction Factor

The COST-231 propagation model works in such a way
that the maximum (Dense Urban) attenuation is
calculated and then a correction factor is applied to
generate the other environment attenuations. Probe
allows the user to enter a custom correction factor instead
of using one of the model defined corrections. In general,
this correction factor should be a "negative" number (dB
attenuation).
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Probe Menus

Probe has six main menus. For information on a specific menu,
click the corresponding link:

File Menu - Common file options.

View Menu - General interface and setup options

Map Menu - Map specific options

Report Menu - Used for generating various printable reports



Tools Menu - Other tools included with Probe

Help Menu - Menu with help options and about box
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New Study

Create a new study ( see Using the Wizard for information on
how to set up a new study ).



Open Study

Open a saved study.

Save Study

Save the current study. If you have saved this study before, it
will be saved to the same file. If this study has not been
saved, you will be prompted for a file name.

Save Study As

Save the current study, using "Save As" will always prompt
for a filename.



Close Study

Close the current study.

Export Map to Graphics File 

Use this to create a graphics file (BMP, JPG, GIF, or PNG)
which contains the current map. See "Exporting the Map to a
Graphics File" for more information.

Export Transmitter List To a File

This option will export the transmitters in the study to a file
which can be loaded as the list of possible interferers in a
future interference study. Use this feature if you wish to run
an interference study with the exact same 'possible
interferers' list that the current study has.

Print

Print the currently displayed map.



Print Setup

This will bring up the printer settings dialog, where the
properties of the printer can be changed.

Recent Files

Probe keeps a list of recently accessed files which can be
loaded using one of the quick links on the file menu.

Exit

Exit Probe. You will be asked if you wish to save the current
study, then Probe will close.
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Toolbars

Toolbars is a pop-out style menu that allows you to select
which tool bars are currently visible. Use this to hide/show a
particular toolbar.



Path Setup

This will open the path setup window where you can
configure the paths to the databases that Probe requires.

Terrain Path Setup

Opens the Terrain Setup window where the terrain settings
are established.

Population Data Path Setup

Opens the population database setup window where the
paths to the available population databases can be
configured.

Study Defaults



Use this to configure the defaults used when creating a new
study.

Unit Setup

Setup the default units to be used by Probe for signal
strength and power.

Windows

Shows the list of available windows in the window list form.

Edit Study and Transmitter List

This will open the study editing window. Use it to modify
transmitters in the study, access contours associated with
each transmitter, and make changes to the study settings.
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Copy Map to Clipboard



This will copy the current map to the Windows clipboard.

Add to Map

Use this to add objects to the map.

Special Effects

Use this to select the special effects that are used in signal
plotting.

Signal Coloration Mode

This pop-out style menu can be used to switch between the
standard cutoff mode (where the same field strength cutoffs
are used for every transmitter) and the "TV Band Based"
cutoff mode (where field strength cutoffs can be defined for
each TV band).



Draw Mode

This sets the draw mode depending on the type of study you
are performing. See "Draw Modes" for more information.

Commands

These map related "commands" tell the program to perform a
specific task.

Map Features

Allows you to set up the overlays used on the map. See
"Setting Up Map Colors" for more information.

Signal Cutoffs/Colors

This will load the signal cutoff window which can be used to
set the cutoffs and colors used when drawing signal to the



map.

Signal Display Options

Shows the signal display options window where things such
as signal transparency and interference plotting options can
be configured.

Layout

Brings up the "Layout Settings" form, which can be used to
modify the current pages margins and size.

Map Settings

Allows you to set the center coordinates of the map, scale,
and projection. See "Map Settings".



Transmitter Token Settings

Configure how transmitter tokens are displayed on the map.

Page Layout Templates

Save and load page layout templates.

Display Options

This will bring up the Display Options Form which can be
used to set all mapping/drawing options.
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Population

For coverage studies this will show the Population Report
Form, from which you can select the parameters of the
population report. For interference studies, this menu item
will create an interference population report with county by
county break down.



TV Band Based Population 

Generates a population report based on the TV Band based
cutoffs defined for the study.

Generate Table 

Use this to generate a table of signal values along certain
azimuths. See "Signal Table Generation" for more
information.

Study Information

This will output information for the current study including the
transmitters involved and the parameters used in the
calculations.

TV Interference Cull List (Optional in the DTV Module)

Generate a TV interference cull list report.



Zip Code Coverage (Optional)

This option can be used to generate a report of the zip codes
which are covered by a user specified field strength. [ Note:
This option is only enabled for users who have purchased the
Probe zip code centroid database. ]

Additional Interference Reports

There are two additional reports that appear on the Report
menu when they are available.

Interference Cell Report - Shows the population and relative
location of the interference cells in the study.

Masking Report - Shows the stations that were considered
for masking and cells where masked interference was found.
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BMP Switch 

BMP Switch allows you to quickly switch back and forth
between multiple BMP files containing map images.



Coverage Matcher (Optional in DTV Module)

Loads the coverage matcher window.

Profile Viewer 

Opens the profile viewer. To define the profile end points
graphically, use the profile tool to access the profile viewer.

Data Export 

Opens the data export window which allows the user to save
signal data generated by Probe to a file.

Text Editor

Open the standard Probe text editor (like the one used for
text reports).



Contour Overlap 

Shows the contour overlap window where contour overlaps
can be specified, edited, and have population reports
generated.

NAD Conversion 

This opens a NAD coordinate conversion utility, which can be
used to convert coordinates from NAD27 to NAD83 and visa
versa.

HAAT/COR Calculator 

Calculates HAAT from COR and vice versa.

Point Info Report 

Generate a point information report (a study must be open for
this option to be available).

Multiple Contours 



The multiple contour tool allows contours to be added to
several stations in the study simultaneously.

Database Cull 

The database culling feature allows data to be drawn from
the FCC databases using user defined selection rules.

Delta h Calculation 

Calculate "delta h" values for a given location and azimuth.
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The transmitter properties form is used to setup transmitter and
propagation model parameters. The following picture shows the
transmitter properties form (before any data for the transmitter
has been added) with a few key areas of the form highlighted.



The first thing to note are the page selection tabs at the top of
the form. Because all of the parameters for the transmitter could
not fit on to one screen, the transmitter properties form is broken
into a series of "pages". You can switch pages by clicking on the
tab for the page you wish to see.



The second highlighted area is the "Load From FCC Database"
button. If you would like to perform a study with an existing
station, the first thing you should do is click on this button to
select a station from the FCC database.

The third highlighted area is the propagation model selector. Use
this to select the propagation model. Since each propagation
model requires different inputs, the propagation parameters are
located on a separate "page". Changing the propagation model
will cause the appropriate parameters tab to appear at the top
along with the other page selection tabs. For propagation model
inputs see: "Propagation Models".

Changing "pages"

By clicking on the tabs located at the top of the form, you can
change the active "page". There will usually be four tabs at the
top:

Transmitter



This is the page shown in the illustration, where the
properties of the transmitter itself are entered.

Antenna

This page is used to set the antenna pattern for the
transmitter (see "Using the Antenna Pattern Editor" for
information on editing the azimuthal pattern and the
"Vertical Elevation Pattern Editor" for information on
changing the vertical pattern). All new transmitters default
to an omni-directional pattern.

Info

Use this page to specify the city, state, and organization
with which the transmitter is associated. This page also
has a selection for whether or not the call letters for the
transmitter are displayed on the map with the transmitter
token (or whether the transmitter token is displayed at all).



"Propagation Parameters"

The label on the fourth tab will depend on the propagation
model selected. You may set the propagation parameters
for the desired model by clicking the tab.

Entering original transmitter parameters

In order to enter parameters for a new station not found in the
database, do the following:

Specify the Broadcast Type

Using the radio buttons next to the propagation model
selector, choose the appropriate broadcast type for this
transmitter.

Specify the Frequency and Channel Number



If the correct broadcast type has been selected, you should
only need to enter either the frequency or the channel
number (as you enter these values in one box, the
appropriate value should appear in the other). Note, the
frequency is specified in megahertz.

Set the Latitude and Longitude

Enter the coordinates of the transmitter in the boxes labeled
latitude/longitude. For help on the coordinate formats
available see "Entering Latitudes and Longitudes". If the
"Auto" check box (on the right hand side of the window) is
turned on then the base elevation will automatically be
calculated from the terrain database when changing the
coordinates. If it is off - the you must click the "Get Elevation"
to retrieve it, or enter a known value in the "Base Elevation"
edit box (if you are in base elevation + AG height mode).

Specify the ERP (Effective Radiated Power)



Enter the ERP for the transmitter in the edit box labeled
"ERP". Use the drop down list box next to the ERP edit box
to specify what units the ERP is in. Note that ERP is the
transmitter power with respect to a dipole antenna, so the
maximum power radiated by the transmitter in any direction is
actually the ERP + 2.15 dB. If you have the EIRP (which is
the power with respect to an isotropic radiator), then you
must convert it to ERP for use by the program by subtracting
2.15 dB or dividing the kW value by 1.64.

Set the Transmitter's Identification

The transmitter's identification should be the call letters for
the station or some other abbreviation that identifies the
transmitter. The identification is drawn on the map as part of
the transmitter token. It is also used to identify the transmitter
in population reporting.

Specify the Center Of Radiation (COR)

The center of radiation can be entered in one of two ways:



1. Specify the base elevation and transmitter height above
ground. If you have entered the latitude and longitude of the
transmitter site, Probe can find the base elevation from the
terrain database for you, simply press the "Get Elevation"
button and the elevation above mean sea level (in meters)
will appear in the box labeled "Base Elevation". Then enter
the transmitter's antenna height above ground in the edit box
labeled "Antenna Height AG". Note this height is in meters.

2. Specify the antenna height above mean sea level. In order
to do this, click the large button labeled "Specify Xmitter
Height AMSL". This should replace the edit boxes for base
elevation and above ground height with one edit box labeled
"Antenna Height AMSL". Enter the antenna height above
mean sea level (in meters) in that box.

Specify the Propagation Model

Use the propagation model selector shown in the picture to
select which propagation model should be used in signal
calculations for the transmitter. When you change the
propagation model selector, a new "Page Selection Tab" will
appear at the top of the window for that propagation model
(clicking on the tab will take you to the propagation model's
parameters page). For propagation model inputs see:
"Propagation Models".



Notes:

HAAT

The HAAT that is shown in this window is not used and is
mainly for display purposes (it is not used in calculations,
with the exception being if the antenna is shown as being
underground in OET 69 studies, it is used). If the station
was loaded from a database then the HAAT will show the
value loaded from the FCC database. If the "Auto" button
is checked, the HAAT will be automatically updated when
the antenna height or base elevation is changed.

The "Auto" Check box

If this box is checked, then the coordinates, base
elevation, antenna height, and HAAT edit boxes become
linked so that changing one of their values will update the
others as appropriate. If this is unchecked, then the
program does nothing automatically and it is up to the
user to update these variables individually.



The Class Selector

The class selector is only available for FM stations. The
"Max" button will set the center of radiation and ERP to
match the maximum allowed for the specified class.

The Import and Export Buttons

Use the "Import" and "Export" buttons to load and save
transmitter properties to a file. This is useful if you are entering a
new transmitter which you plan on using in a future study. You
can use the "Export" button to save all of the transmitter
properties (including antenna pattern, station info, and
propagation parameters) to a file. Use the "Import" button at
some later date to load previously saved transmitter properties.
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To load a station's transmitter parameters from the FCC
database, click on the "Load From FCC Database" button on the
Transmitter Properties Form. Here is what the FCC search
window looks like after a search has been performed:



Searching is fairly straightforward, first select the database that
you wish to search in the box at the top of the window labeled
"Database". The TV/DTV database is the standard FCC TV
engineering database, the DTV Allot database contains the DTV
allotments, FM is the standard FM engineering database, and
the FRZ database is a "Frozen" TV database consisting of the
TV database at the time that the DTV allotment database was
created.



Next select whether to search the entire database, or just a
certain state (to search a specific state click on the "By State"
radio button and enter the two letter state abbreviation in the edit
box). Now enter a search string into the edit box labeled "Search
For" and press the enter key (or press the find button). The
program searches for the search string in the entire record, so
you can enter any string value - like call letters, city of license,
file number, etc. After the "Find" button is clicked, a list of
stations that match the search string will be displayed in the list.
To view the details of one of the found records, select it in the list
and then click on the "Details" tab (you can also right click with
the mouse on the results list to toggle between details and list
mode). Click the "Accept" button to load the selected record.

When loading a station from the TV/DTV, DTV allotment, or FRZ
database the "Apply OET69 Vertical Elevation Pattern" check
box will be shown at the bottom of the window. If this box is
checked, then the generic OET69 vertical elevation pattern for
that station will be automatically assigned (if left unchecked a
uniform full field vertical pattern will be assigned).
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To view/edit a transmitter's antenna pattern click the "Antenna"
tab on the transmitter properties form. This will display a page
which shows a picture representation of the antenna pattern.
Click the "Change Pattern" button to load the antenna pattern
editor. Here is an example of what the antenna pattern editor
looks like:



Probe is capable of handling antenna patterns of a resolution up
to 0.5 degrees. The zero degree azimuth is true north (this is the
"up" direction on the graph). Antenna pattern values for any
general radial are generated by interpolating between points
which have been defined, so an antenna pattern can have
anywhere from 1 to 720 points. Antenna patterns are stored as a
list of values associated with azimuths and some "Rotation
Angle". This rotation angle is the amount (in degrees) that the
pattern is to be rotated when used by the program (this rotation is
in a clock-wise direction).

Antenna Pattern Editor Functions



Inserting a Point

To insert a point into the antenna pattern, click the "Insert
Point" button. This will bring up a window asking you for the
azimuth and pattern value at that azimuth. Since the
maximum antenna pattern resolution is 0.5 degrees, the value
you enter for the azimuth will be rounded to the nearest 0.5
degree increment (for example, entering and azimuth of 10.2
degrees -- will be considered as 10.0 degrees, and entering
and azimuth of 10.6 degrees will be considered as 10.5
degrees).

Deleting a Point

To delete a defined azimuth from the antenna pattern,
highlight the azimuth you wish to remove and press the
"Delete Point" button.

Editing Points



To edit the antenna pattern value for the point, select the
azimuth you wish to edit. Then type in the new value for that
azimuth in the edit box located below the antenna pattern list
box. After typing in the value, press the ENTER key.

Changing the Edit Mode

The antenna pattern has two modes for editing. First is the
"Pre-Rotation" mode. In this mode, all antenna pattern
azimuths will be referenced before the pattern is rotated by
the specified rotation angle. The "Post-Rotation" mode is a
mode where all antenna pattern azimuths will be referenced
after being rotated through the specified rotation angle. The
reason for having two modes is because you may wish to
enter a standard antenna pattern with values from the
antenna's data sheet (these will be Pre-Rotated values), and
then rotate it to suit your transmitter's needs. Because Probe's
antenna patterns have a fixed maximum resolution (of 0.5
degrees), there would be a loss of accuracy if only the "Post-
Rotation" mode existed.

Rotating the Antenna Pattern

To rotate the antenna pattern in a clock-wise direction, enter
the amount (in degrees) of rotation in the edit box located next



to the rotated button (either by using the up/down arrows or
manually entering it in the edit box), and then press the
"Rotate" button.

Clearing the Antenna Pattern

Press the "Clear Pattern" button to reset the antenna pattern
to an omni-directional pattern (this is the default pattern that
comes up for new stations).

Loading and Saving

Probe is capable of loading and saving antenna patterns in
three different formats:

Original V-Soft Pattern Format

Use this file format if you want your antenna pattern to
be compatible with other V-Soft applications. Note



however that this file format is capable of storing
patterns at a maximum resolution of 1 degree, so if you
have any azimuths defined at 0.5 degree increments
there will be a small loss in precision.

Probe's Enhanced Antenna Pattern Format

This is the recommended format for saving antenna
patterns generated with Probe, however it is not
compatible with all of V-Soft's other programs.

Dielectric Azimuthal Antenna Pattern Format

Probe can read and save to the standard azimuthal
pattern format distributed by Dielectric.

ERI Format



This is the ERI format that has a standard file extension
of .TXT.

Andrew Text Format

The .PAT text file generated by some Andrew pattern
software.

CSV Format

This is a "Comma Separated Value" format that is
generated by some antenna planning tools.

Printing

To print the antenna pattern press the "Print" button. This will
print a page containing the pictorial representation of the antenna
pattern and a table of azimuths/values. The antenna pattern
editor prints using the default printer and its current settings.
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To view or edit a transmitter's vertical elevation pattern, click on the
"Antenna" tab on the transmitter properties form. Then click the
"Change Vertical Pattern" button to display the vertical elevation
pattern editor.



The buttons in the lower left hand part of the window can be used to Add,
Remove, and Edit points. The "Clear Pattern" button will remove the
current pattern and apply a uniform full field pattern. Electrical beam tilt
can be assigned in the edit box labeled "Beam Tilt". This will be reflected in
the graph and used in signal calculations -- however the table on the right
will still reflect the "pre-tilted" pattern. Mechanical beam tilt can be
supplied in the box labeled "Mechanical Beam Tilt" (use the check box at
the top to have the mechanical tilt included in the plot at the specified
azimuth). The "Shift Pattern" button can be used to shift the entire vertical
pattern, using this function affects the "pre-tilt" values shown in the table.

Loading and Saving



Probe is capable of loading and saving vertical elevation
patterns to three different formats:

Generic Vertical Elevation Pattern ( .vep )

The generic vertical elevation pattern is a simple ASCII
format which can be used to store patterns for later use.

Dielectric Vertical Elevation Files ( .el )

This is the standard format distributed by Dielectric.

CSV Format (.csv)

This is a comma separated value format used by some
other programs.
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Use the study edit window to add and remove transmitters from a
study. You can also use it to view transmitter properties and
plotted signal contours. To access it, choose "Edit Study and
Transmitter List" from the View Menu.



Adding Transmitters

To add a transmitter to the study, click the "Add" button. The
area of calculation for the new transmitter will be set to the
study default, but can be changed by selecting it and clicking
the "Edit AOC" button.

Removing Transmitters

Select the station you wish to remove and click the "Remove"
button. After the "OK" button is clicked, some re-calculation



may occur in order for interference studies to update.

Transmitter Properties

To view the properties of a transmitter, select the transmitter's
call letters and click the "Edit" button. The "Transmitter
Properties" form will appear and the transmitter properties can
be edited.

Contours

The contours applied to the selected transmitter are shown on
the right hand side of the window. Here you can add, remove,
and edit the station contours. The check box shown selects
whether the given contour is plotted on the map.

Area of Calculation

The area of calculation for the selected transmitter is shown at
the bottom of the right hand side of the window and can be
edited by clicking the "Edit AOC" button.

Study Options



The right hand window shows study specific options that can
be changed. Changing these will generally cause the program
to completely re-calculate signal and interference. Use the
"Study Specific Options" button (if enabled) to change options
specific to the type of study open (for example, edit the
masking list for outgoing TV studies where masking was
considered).

Misc Options

Import AM DTC - This option allows the user to specify a .DTC
file created by another program. Probe creates a new
transmitter that has the call letters and coordinates from the
.DTC file and loads all contours within that file as imported
contours.
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When defining the area of calculation, the following window appears:



Use the drop down list box at the top of the window to select the type of
area you wish to assign to the station.

Circle Centered at Transmitter Site

Choose this if you want each transmitter in the coverage study
to have its signal calculated within some distance from the
respective transmitter's site. With this option you can specify the
distance in the second box on this page.

Region Defined by Latitude/Longitude Boundaries

Select this option to calculate the signal for all transmitters in the
study within some Latitude/Longitude based rectangle. After
selecting this alternative you will be able to enter the coordinates
of the corner points of the rectangle in the second box on this
page (see Entering Latitudes and Longitudes for help on
coordinate formats that Probe accepts).

Area within Grade B Contour



This option will use an area containing all cells within each
transmitter's dipole adjusted Grade B FCC contour. If any of the
stations in the study are not TV or DTV stations, coverage will
be calculated within their F(50-50) FCC 60 dBu contour.

User FCC Contour

Choose this option if you wish to calculate signal in an area
bounded by a station's FCC contour. After selecting this
alternative you will be able to select the signal cutoff value of the
FCC contour and the time variability [ie. F(50-10), F(50-50),
F(50-90)].

Station Based FCC Contour
This also allows for a standard FCC contour to be used,
however there is no selection for the time variability (it is chosen
automatically based on the station type - F(50-50) for NTSC TV
and FM, and F(50-90) for DTV).

General Options

Number Of Radials - This defines the number of actual points
on the contour to be calculated (other radial distance to contour



values will be calculated by interpolating between these points).

Use 8 Radial HAAT - This will cause the contour to be
calculated using HAAT calculated for 8 evenly spaced cardinal
radials and HAAT values for other radials being calculated by
interpolating between these values.
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The transmitter list box displayed in the main window allows you
to select which transmitters are displayed on the map and to
define the color associated with each transmitter in the study.



The top of the transmitter list box shows the current draw mode.
Use the check boxes in the first column to select whether the
associated transmitter's signal or interference is displayed on
the map. For drawing interference and highest signal, the color
used for each transmitter can be selected by double clicking on
the colored box next to the station's call letters. After making
changes to the transmitter list, you must click the "Redraw"
button to redraw the map.

Double clicking on a transmitter's call letters will display the
station's parameters on the "Transmitter Properties" form. Right
clicking on a station's call letters will display the station's contour
list.

The All/None Buttons

Use these buttons to select either all or none of the stations
in the list.

The Redraw Button

Use the redraw button to redraw the map. You will need to
click this button if you make any changes to the transmitter
list or change any of the pop-out style menus on the "Map"



menu.

The Display Options Button

Use this button to load the "Display Options" form which will
allow you to change all of the various map settings and
options. After exiting the "Display Options" form, the map will
automatically be redrawn.

 

 



 

 

 

Profile Viewer
Previous

Top

Next

 

The profile viewer can be used to view elevation profiles, signal
along a profile, and Fresnel zones.



To open the Profile Viewer, use the Profile tool or choose "Profile
Viewer" on the "Tools" menu.

Manually Entering Profile Parameters

To specify the profile you wish to view, type in the latitude and
longitude for the starting point, and either specify a



latitude/longitude for the end point, or enter a distance and
bearing in the appropriate edit boxes ( NOTE: The distance is
in kilometers and the bearing is in degrees). After you have
entered the parameters for the profile you wish to view, press
the "Draw" button to draw the profile. For options for entering
latitudes/longitudes in Probe see: "Entering Latitudes and
Longitudes".

Choosing what gets displayed

Use the check boxes in the upper right hand corner of the
profile viewer window to choose what you want to display. The
color of each item can be changed by clicking on the color box
next to the corresponding item. If you choose to display a
Fresnel zone, you can pick which zone is displayed by clicking
the appropriate radio button located under the "Fresnel" check
box. Use the "Antenna Properties" button to set the
transmitter height, receiver height, and frequency to be used
in the Fresnel calculations.

Displaying Signal

The profile viewer will display interpolated signal values for a
given transmitter if they are already calculated in the study.
You can use the drop down box (to the left of the cancel
button) to select which transmitter's signal gets displayed
along a profile (if you used the profile tool to select the profile,
this will default to the transmitter to which the starting point is



snapped).

Earth's Curvature

You can set the earth's curvature "K" constant which is used
in computing the elevations in the edit box located directly
above the close button. Typical values for this constant are
1.33 for 4/3 earth and 1.0 for true earth. Setting this value to 0
(or <0) will cause the profile viewer to use flat earth (i.e.. no
elevations will be added to the profile to compensate for the
earth's curvature). The earth's curvature is displayed as the
amount of elevation (in meters) added to the profile as a
function of distance, however all of the elevations will be
shifted up by the minimum value of the elevation graph (this is
so the earth's curvature can be displayed with the rest of the
profile).

Copying to the Windows Clipboard

To copy the graph shown in the window to the Windows
clipboard, click the "Copy" button. This will allow you to then
paste this profile into another application, such as a word
processor or graphics package.

Saving to a Windows Bitmap



Click the "Save" button to save the current profile to a
Windows Bitmap (.BMP) file. When "Save" is clicked you will
be prompted for a file name.

Printing

To print the current profile, click the "Print" button. The
following box will appear in the window:

You may enter a title for the printed output in the edit box labeled
"Title:". Probe will print a full page printout of the current profile.
You may choose whether this is printed in landscape or portrait
mode (Landscape is the default printing mode). Press "OK" to
send the profile to the printer.
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Probe's advanced database culling feature can be accessed by
choosing "Database Cull" from the "Tools" menu (or clicking the
"Cull" button in the coverage study wizard).



The box labeled "Requirements" is where the rules that determine what is
retrieved from the database are defined. Use the "Add", "Edit", and
"Remove" buttons to change the query. Select the database you wish to cull
from in the "Database" box. Click the "Query" button to retrieve the records
from the database that match the requirements. Note - if the "Clear List on
Query" box is checked, then the results will be cleared before searching. If
it is unchecked, then the results will be added to the list that is already
displayed.



The "Reference Point" box is where the point that is used when distance is
part of the query is defined. Use the "US City" button to load the point from
the US city database. The "Station" button will allow the user to load the
point from the FCC station database.

Items can be removed from the list using the "Remove" button. The list can
be printed by clicking the button that has a picture of a printer on it. Use the
"Clear List" button to clear the entire list.

Requirement Variables

Record - This compares the entire records to the specified
string.

Distance - This compares the distance from the point defined in
the "Reference Point" box.

LicType - The license type field of the record is compared to the
supplied string.



CallSign - The call sign field of the record is compared to the
supplied string.

State - The state field of the record is compared to the supplied
string. Note, this is the state abbreviation (example: IA = Iowa).

City - The city of license field of the record is compared to the
supplied string.

Azimuth - The azimuth from the point defined in the "Reference
Point" box is compared to the entered value.

Channel - The channel field of the record is compared to the
supplied channel number.

Service - The field of the record is compared to the supplied
string.



Class - The class field of the record is compared to the supplied
string.
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The "Multiple Contour Tool" can be used to add a contour to several
stations simultaneously. To use it select "Multiple Contours" from the
"Tools" menu.



The marks in the station list on the left hand side of the window show
which stations will have contours added. Choose the type of contour to add
at the top of the right hand side. Each contour type has specific properties
that can be configured in the section below the type selection. Below, the
appearance properties for the contours can be configured. Select "Use
Transmitter Color" to have the contours default to being the same color as is
associated with the transmitter in the "Transmitter List". Select "Use
Specified Color" to have all contours added be displayed with the color
specified in this window. Click the "Add Contours" button to add the
configured contour to each station selected in the list. The "Remove
Contours" button will remove ALL contours from the study.
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The coverage matcher can be loaded by choosing "Coverage
Matcher" from the "Tools" menu. The coverage matcher is
intended to be used for TV and DTV, when you wish to change a
station's parameters and match the original transmitter's grade B
contour (this is accomplished by varying the new station's
antenna pattern). Here is what the coverage matcher looks like
when first loaded:



How to use the Coverage Matcher

As you can see, the coverage matcher window is divided into
two sides. The left side contains the parameters of the
existing station, the coverage of which you wish to match.
The right side contains the parameters of the new transmitter
that you wish to match. Before performing the coverage
match, each transmitter must be loaded using the "Configure
Transmitter" buttons (this will pop up the Transmitter
Properties Form). Once a station is loaded, you can view its
antenna pattern by clicking on the "View/Edit Antenna
Pattern" button ( this displays the Antenna Pattern Editor ).



There are two ways that the coverage matcher can perform
the matching process:

Varying the New Transmitter's Antenna Pattern

This type of matching will keep all of the new station's
parameters as they were entered, and only vary the
new transmitter's antenna pattern. In some instances,
the "distance to contour" required to match the existing
station's coverage will be greater than the transmitter
is capable of reaching at full field. In these cases, the
antenna pattern in that direction will be set for a full
field -- meaning that the coverage in that direction will
not be matched (the "distance to contour" for the new
transmitter will be less than what it needs to be in
order to match the existing transmitter's coverage). To
use this mode, make sure that the "Vary Power" check
box at the bottom is unchecked.



Varying the New Transmitters Antenna Pattern and
Power

This type of matching will change the antenna pattern
and the power of the new transmitter. The reason you
would want to do this is to compensate for the fact that
the "distance to contour" needed to match the existing
station's coverage in some directions may be
unreachable using the transmitter's initial power ( the
problem discussed in the previous paragraph). This
type of matching should be able to match the existing
station's coverage exactly. To use this type of
matching, make sure that the "Vary Power" check box
is checked.

When you have entered the parameters for the existing
transmitter and the new transmitter, and have set the "Vary
Power" check box to the desired state, press the "Find
Match" button. There will be a short delay while the required
antenna pattern (and power if the "Vary Power button was
checked) for the new transmitter is calculated. When Probe is
finished calculating, the required antenna pattern will be
displayed in the Antenna Pattern Editor. At this point, you can
save/print the required antenna pattern. If you clicked "Find
Match" with "Vary Power" checked, the coverage matcher will
display the required power for the new in transmitter in the
place labeled ERP on the right hand side of the coverage
matcher window.



Examples of Using the Coverage Matcher

DTV Allotments

The coverage matcher is intended to give results similar
to the method used by the FCC to create the DTV
allotments based on the original NTSC coverage. If you
wish to take an NTSC station and create a DTV station
which matches the original NTSC stations coverage, load
the NTSC station into the "Transmitter Coverage to
Match" side of the coverage matcher (the left side). Then,
enter the parameters of the new DTV station into the
"New Transmitter to be Matched" side of the coverage
matcher (the right side). Set the "Vary Power" check box
to the desired setting (discussed above), and click the
"Find Match" button. This will tell you what antenna
pattern (and power if varied) the DTV station requires to
match the original NTSC stations coverage.

Moving a Transmitter



If you wish to move a transmitter's site and you want to
find out what antenna pattern would be required to match
the coverage of the original location, enter the parameters
for the original station on the left side. Then enter the
parameters for the new transmitter on the right side.
Choose whether or not you would like to vary the power,
and press the "Find Match" button. This will calculate the
antenna pattern that is required to match the coverage
from the old site.
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BMP Switch will allow you to quickly alternate between multiple
saved bitmaps. To load the BMP Switch program select "BMP
Switch" from the Tools Menu.



The letters A through H are reference letters representing the
bitmaps that you can load and from which you can switch back
and forth. To load a bitmap, select the letter you wish to assign
and press the "Load" button. Once you have loaded the bitmaps
you can switch to them by clicking their associated letter. If you
wish to quickly switch back and forth between two bitmaps, use
the drop down list boxes located above the "Switch" button to
select which two bitmaps you wish to alternate. To switch between
them, click the switch button. On the right side of the bar at the top
of the screen, the large letter in the box shows which bitmap is
currently being displayed. The area where it says "No File
Loaded..." will show the filename of the currently viewed bitmap
when loaded.
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The contour overlap list can be accessed by choosing "Contour
Overlap" from the Tools Menu.



The contour overlap list contains a list of all the contour overlap regions
defined for the current study. Here a new overlap region can be defined, or
an existing overlap region can be edited or removed from the study.

Overlap regions that are plotted on the map are plotted in such an order that
the ones that appear first on this list are plotted first on the map. Use the red
up and down buttons on the right hand side of the window to change the
location of the selected overlap region in the plot order.

To generate a population report for the area within an overlap region, select



the region's name from the list and then click the "Population Report"
button.

Service Counting Options
The functions in the "Service Counting Options" section are
specifically designed for determining the uniqueness of service of a
given transmitter using contours as service regions. So, the "First
Service" area will be all the locations where the reference station is
the only station with service to that area. "Second Service" is all the
areas where the reference station and one other station provide
service, and so on.

Build Overlap Areas
This function will automatically determine overlap relationships
for all stations in the study. When the "Build Overlap Areas"
button is clicked, the following window appears:



The number of services selection determines how many service
combinations are considered. This number should be set to a
fairly low value, as the number of possible combinations
increases dramatically with the number of services (and number
of transmitter included in the study). Select a service count in the
list and click the "Edit" button to change the color assigned for it.

Service Count Report
This function assumes that the contour overlap list was
generated by using the "Build Overlap Areas" feature. If this was
not used, then the service contour report may contain
unexpected results. This report gives a population count of each
of the service count areas considered.



Defining Contour Overlap Regions

The "Overlap Region" edit window has three sections. The "Transmitter"
section on the left is used for selecting a transmitter's contour to add to the
overlap region. Use the drop down list box at the top of this section to select
the transmitter. When a transmitter is selected, a list of its defined contours
will appear. Here contours can be added, edited, and removed from the
selected transmitter.

The "Overlap Region" section on the right shows all of the contours that are
contained in the current overlap region (the name of the overlap region is



also defined here). Select a contour from the left side of the window and
then use the "- >" button to add the contour to the current overlap region. If
the "Auto Name" check box is checked, then the region's name will be
automatically defined by showing the call letters for the station associated
with each area in the overlap region separated by slashes.

The "Type" selection on the overlap region side of the window specifies
type of overlap region. An "Intersection" overlap region consists of all
points that are contained within all of the contours considered for the
region. The "Union" overlap region consists of all points that are contained
in any of the contours considered for the region.

The "Plot Options" section at the bottom of this window is used to define
how/if this overlap region will be plotted on the map.

NOTE:
When a contour overlap region is created, its area becomes
fixed. If a transmitter's contour is changed outside of the contour
overlap editor, the user will need to "re-add" it to the overlap
region.
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When creating a point report or adding a user defined tick mark,
the street level data can be searched to find the coordinates of a
street address.

The street level data is organized by five digit zip code. When
finding the location of an address, the street name must exactly
match the street name in the database. After entering a zip code
and part of the street name, click the search button to get a list
of all the streets in the zip code that match the "street" string...
then select one of those to use as the street. When entering the
"number" you must enter a whole number (for example if you are
looking for number "13B" just enter "13" for the number).
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To open the NAD conversion utility, choose "NAD Conversion"
from the Tools Menu.

This simple utility converts coordinates from NAD27 to NAD83
and vice versa. To convert from NAD27 to NAD83, enter the
NAD27 coordinates in the Latitude/Longitude edit boxes on the
left side of the window, the NAD83 coordinates on the right side
of the window will be automatically updated to reflect the new
NAD 27 coordinates. To convert from NAD83 to NAD27 just
enter the coordinates on the right hand side of the window.
NAD27 coordinates can be retrieved from the V-Soft Reference
file using the reference buttons.

 





 

 

 

HAAT/COR Calculator
Previous

Top

Next

 

The HAAT/COR calculator is designed to calculate a HAAT (Height
Above Average Terrain) value given a COR (Center Of Radiation)
value, or calculate a COR value from a HAAT value. It can be
accessed by selecting "HAAT/COR Calculator" from the "Tools
Menu", or by clicking the "HAAT" or "COR" button on the transmitter
properties window.



Enter the latitude and longitude of the transmitter site. Use the "Number Of
Radials" drop down list to select the number of radials considered in the
average terrain calculation. Finally, select the broadcast type and click the
"Update Average Terrain" button to cause the window to display the HAAT
and AMSL height section at the bottom of the window. Here, if you enter a
value in the HAAT edit box, the AMSL edit box will automatically update.
If you enter a value in the AMSL Height edit box, then the HAAT will
update automatically.
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To generate a spread sheet style table showing the signal values
along radials, choose "Generate Table" from the "Report" menu.
The following window will appear:



You can select the bearing (in degrees) starting point, ending
point, and increment ... as well as the distance (in kilometers)
along each radial's starting point, ending point, and interval. Use
the drop down list box labeled "Transmitter" to select which
transmitter's signal values are used. Press "OK" to generate the
table. The table will be displayed on a "Grid Output" form.

The parameters shown in the picture would generate a table
which contains the following bearings:

{ 0, 10, 20, 30, ..., 340, 350, 360 }

Each radial would show the signal strengths at the following
distances:

{ 0, 5, 10, 15, ..., 90, 95, 100 }

NOTE: This report uses interpolated signal values from the
current study (it does not generate new signal values). If you
choose a distance which contains points where the signal has



not been calculated, an NC will appear in those cells where no
signal exists.

 

 



 

 

 

The Grid Output Form
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Use the "Signal Table Generator" to display signal values in a
spread sheet style table. The "Grid Output" form looks like this:



Saving Data

To an ASCII File

To save grid data to an ASCII (text) file choose "Save as
Text File" from the "File" menu, or click the second speed
button at the top. This will save to a column style text file
which can be imported into Microsoft Excel.



Copy to Clipboard

Copying the entire table to the clipboard

To copy the entire table to the clipboard choose "Copy All"
from the "Edit" menu (or click on the first speed button at
the top). You should then be able to paste the table into
Excel (by choosing "Paste" from the "Edit" menu in Excel).

Copying selection to the clipboard

You can select certain cells by clicking on them and
dragging the mouse. If you wish to copy the selected cells
to the clipboard choose "Copy Selected" from the "Edit"
menu.



Printing

To print the table to the default printer, choose "Print" from the
"File" menu, or click on the fourth speed button at the top.
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To create a signal based population report for a study, choose
"Population" from the Report Menu. For interference studies,
special population report options will appear (see "Incoming
Interference Population Reports"). For coverage studies, the
following window will appear:



There are three types of population reports you can generate for
coverage studies. If you have more than one transmitter in the
study, population reports will be displayed for each transmitter.

Simple Report

This report displays the total population count where the
signal for a station is above the specified field strength
cutoff.



Report Based on Map Cutoffs

This report displays the population for each field strength
cutoff defined in the current study (see "Defining Cutoffs"
for help with cutoffs).

County Breakdown Report

This type of report will display a county by county
breakdown of the census information for areas where the
field strength values are greater than the specified cutoff.

Population Reporting Options

Include Racial Breakdown

This will cause the population report to include a racial
breakdown as well as the total population covered.



Use Interpolated Signal Values

If interpolated signal values are used, the signal will be
found using four point interpolation for each census block
and then compared with the cutoff in order to decide
whether or not it is counted. If you do not use interpolated
signal values, Probe will use the signal value associated
with the calculation cell which contains the census block
for this comparison.

Show Transmitter Info

If this switch is selected, Probe will display transmitter and
propagation model information with the population report.

Treat all transmitters as one "superstation"

This option is only valid in multiple transmitter coverage
studies. If selected, a window will appear where the user
can choose which transmitters in the study will be "joined"



to create one "superstation" for the purpose of counting
population.

Use this option to generate a population report for a
number of transmitters without counting the coverage
overlaps between them more than once. The required
field strength for each transmitter to be counted defaults
to the one that was entered on the first window, however
at this point you can change it by selecting the station in
the list you wish to change and typing in a new signal
level.
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When a population report is performed the following incoming
interference options window appears:



The check list box on the left can be used to specify which
transmitters in the study are considered for incoming interference.
If a transmitter is "unchecked", then the population report data will
appear as though that transmitter was not included in the study.

Use the options on the right to select what appears on the
population report.

Show County Breakdown



This option will display population information for each
individual county where the reference transmitter has coverage
or interference. The county breakdown will show the total
county population, population where the reference station has
coverage, amount of interference contributed by transmitters
that cause interference in that county, and the interference free
coverage of the reference station.

Show Interference Free Breakdown

This option will cause the program to show a racial breakdown
of the interference free population.

Example:

Interference Free Breakdown:

White: 402,060 ( 97.6% )

Black: 1,097 ( 0.3% )



Hispanic: 2,183 ( 0.5% )

Indian: 1,774 ( 0.4% )

Asian: 4,763 ( 1.2% )

Other: 61 ( 0.0% )

Total: 411,938

Show Transmitter List

This will add a list of all the transmitters considered for causing
interference in the study to the population report. This list will
include the call letters, channel number, city of license, state,
distance from the reference station, and bearing from the
reference station.



Report KWX Error Population

This option is only available for OET 69 interference studies. It
will add the KWX error population to the summary section of
the report.

Report DTV Only Percentage

This option is only available for OET 69 interference studies. It
will add the percentage of interference caused by DTV stations
to the summary section of the report.

Baseline Population



There are three different values that the program can compute
percentages with respect to in the report.

Not affected by terrain loss population

The "not affected by terrain loss population" is the total
population within the reference station's bounding contour
where the signal strength is at or above the threshold for
reception for the study.

Bounding contour population

This is the total population contained within the bounding
contour of the reference station.

User defined baseline population

The user can enter a figure to be used as a baseline
population (for example, looking up the baseline population
from the 6th Report and Order Appendix A table generated
at the time the DTV allocations were assigned).

Incoming Interference Population Totals



The summary section of incoming population reports looks like the
following:

It includes the population count for the "area of calculation" (this is
the sum of the population in all of the cells in the study). The
population "Not affected by terrain loss", is the total coverage that
has a signal strength above the threshold for reception. For TV
interference studies, the "total NTSC", "DTV only", and "total DTV"
interference are reported. Finally, the interfered population and
interference free coverage population are reported. This is
followed by the total "percent interference" (which is the "interfered
population" divided by the "baseline population" selected by the
user). The "terrain blocked population" is simply the total number
of people in the area of calculation where the field strength is less
than the threshold for reception.
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Generating a point report

A report for a specific point can be generated by right clicking on
the map with the "Map Information" tool or from the "Tools"
menu. This feature is commonly used for the Satellite Home
Viewers Act studies. When the mouse is clicked the following
window appears:



The coordinates default to the point on the map where the
mouse was clicked, however any set of coordinates where the
signal has been calculated can be entered (use the V-Soft
reference buttons to load coordinates from the reference file or
the "Find street address" button to use street level data to
generate coordinates). The "Transmitter" box is used to define
which transmitters field strength should be reported. Click the
"Create Report" button to create the following type of report:
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A TV Interference cull list shows a list of all of the stations in the
FCC database that are within the culling distance table listed in
8-10-98 FCC Public Notice.



The values on this window default to those of the reference
station in interference studies. The coordinates can be obtained
from the V-Soft reference file using the V-Soft Reference file
buttons. After selecting the values you would like for the report,
push the "OK" button.

The cull list report is fairly straightforward, listing the call letters,
city of license, state, channel number, distance, type (A for
Analog NTSC and D for Digital), and license type (ALD is for a
DTV allotment).
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Choose "Zip Code Coverage" from the "Report" menu to generate a
report of the zip codes that are covered by a user specified field
strength. The following window will appear where the user can
specify which transmitter to generate a report for and other options
pertaining to the report.



Example Text Format Report:

Zip Field Strength Latitude Longitude

---------------------------------------------------------------
---

50634 79.4 dBu 42-25-10.87 N 092-13-11.48 W

52313 66.1 dBu 42-15-14.78 N 092-05-56.26 W



52210 60.4 dBu 42-20-53.33 N 092-00-14.34 W

50643 76.9 dBu 42-22-59.94 N 092-24-58.04 W

50647 70.1 dBu 42-39-57.37 N 092-27-57.09 W

50612 61.7 dBu 42-16-18.87 N 092-23-20.07 W

50613 85.5 dBu 42-31-01.52 N 092-26-09.07 W

50651 77.4 dBu 42-22-10.42 N 092-12-21.96 W
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Interference Cell Report [Interference studies only]

An interference cell report lists all of the cells in the study where
interference exists. It shows the station in question, population of
the interference cell, interference margin, and the distance and
bearing from the reference station and the transmitter in question
to the "cell" where interference exists.

Example:

Interference Cell Report

Reference Station: KPOMTV (24+)



Population Database: 1990 US Census

Call Population Ix-Margin Reference Transmitter

Letters (people) (dB) Dist(km) Bear(deg) Dist(km) Bear(deg)

--------------- ---------- --------- -------- --------- -------
- ---------

KHBS-D.C (21) 46 0.7 75.3 214.0 11.0 40.6

KHBS-D.C (21) 8 0.2 79.3 210.4 9.5 75.3

KHBS-D.C (21) 73 1.4 72.6 213.6 13.8 41.7

KVTN-D.A (24) 53 1.8 56.2 6.5 261.8 316.0

KVTN-D.A (24) 98 1.3 58.1 6.3 263.2 316.3

KVTN-D.A (24) 143 1.1 60.1 6.1 264.6 316.6

KVTN-D.A (24) 261 1.5 69.9 5.2 271.7 318.1



KOKITV (23Z) 35 0.8 61.7 299.4 85.4 93.0

KOKITV (23Z) 0 8.7 67.1 306.8 85.3 86.4

KOKITV (23Z) 0 2.9 55.0 289.6 88.9 100.6

Masking Report [Outgoing TV Interference Studies Only]

The masking report shows which stations are considered as
potential masking stations for outgoing interference studies. It has
two sections. The first section lists the stations that are considered
as potential maskers for each station in the study that is being
examined for interference. The second section lists all of the
"cells" that were not considered as having interference caused by
the reference station because they were masked by one of the
masking stations. This section lists the cells location, desired field
strength ("D"), undesired field strength ("U"), the D/U ratio, and
which station masked the interference.

Example:

KTAJ (16):



WTJR ( 16) Quincy IL

KSNF ( 16) Joplin MO

KCPT-D ( 18) Kansas City MO

KCPT ( 19) Kansas City MO

KDSMTV-D ( 16) DES MOINES IA

KOOD-D ( 16) HAYS KS

KTWU-D ( 23) TOPEKA KS

KMBCTV-D ( 14) KANSAS CITY MO

KMOSTV-D ( 15) SEDALIA MO

KCPT-D ( 18) KANSAS CITY MO

KCTV-D ( 24) KANSAS CITY MO

KCWB-D ( 31) KANSAS CITY MO

KXNETV-D ( 16) NORFOLK NE



KTAJ (16-): [ 39-55-44 N, 094-05-20 W ] D = 66.45 U = 38.46 D/U =
27.99 Masked by: WTJR (16+)

KTAJ (16-): [ 39-57-52 N, 094-04-00 W ] D = 66.83 U = 40.18 D/U =
26.65 Masked by: WTJR (16+)

KTAJ (16-): [ 39-24-48 N, 094-02-40 W ] D = 62.18 U = 36.29 D/U =
25.89 Masked by: KSNF (16Z)
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To print the map that is currently displayed in the main screen,
choose "Print" from the File menu.



Printing Options

Page Orientation - This will default to whatever orientation the
current Page layout is set up for. The user should generally not
change this option from the default unless the "standard mode"
display is currently begin used.

Map Scale - If you wish to print the map at a different scale then
the one shown on the screen map, enter the new scale here.



Print To Transparency - The option displays only the signal,
contours, map objects, and tick marks.

Rasterize Fonts - This option should only be used if fonts do not
display properly on your printer. This option will convert fonts into
'bitmaps' and then draw them on the printer (this will slow printing
considerably and should not be used unless absolutely
necessary).

Print Using Thin Lines - By default the program adjusts the
widths of the lines on the printout to be the same physical width
as they appear on the screen. Use this option to make the
program render lines onto the printing device at the same pixel
width as they are on the screen (this makes the lines appear
much "thinner" than on the screen).

Print Polygons on Raster Layer - This option forces the program
to render polygons onto a bitmap before putting them on the
printing device. This option may lower the "sharpness" of the
polygons and should only be used if your printer doesn't print
properly with it turned off.

Number Of Copies - Sets the number of copies of the map to be
printed. Note - not all printing devices allow for multiple copies



(this option will be greyed out if this is the case).

Current Printer - This shows the printer that is currently selected.
Use the "Printer Settings" button to switch printers or modify the
current printer's settings.
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Probe is equipped with a logical string parser which should allow
you to enter latitude/longitude coordinates in various formats.
The following methods of specifying coordinates are available:

As an example, say we are interested in entering the following
coordinates:

Latitude: 45-09-12 N

Longitude: 111-35-01 W

Long notation



Coordinates may be entered as they are shown above,
specifying degrees-minutes-seconds and direction. If no
direction is specified, latitudes default to "north", longitudes to
"west".

Short notation

Coordinates may be specified in the following shortened
notation:

Latitude: DDMMSS.FF

Longitude: DDDMMSS.FF

Where D is the place holder for degrees, M for minutes, S
for seconds, and F is for hundredths of a second. Our
example coordinates would look like the following in short
notation:

Latitude: 450912

Longitude: 1113501



Also, Probe will allow the user to specify a direction with
short notation:

Latitude: 450912N

Longitude 1113501W

Once again, if no direction is specified, latitudes are
considered to be "north", and longitudes "west". Lastly,
Probe removes all spaces before parsing the coordinates
so the example latitude/longitude could be entered as
follows:

Latitude: 45 09 12 N ( or just "45 09 12" )
Longitude: 111 35 01 W ( or "111 35 01" )

High resolutions coordinates with fractions of a second
can be indicated by adding the number of hundredths of a
second to the coordinates:

Latitude: 450912.45 N

Longitude: 1113501.94 W



Decimal notation

You may also specify latitude/longitude coordinates as
decimals, however these are sign dependent with the
convention of north being positive and east being positive. In
decimal notation our example coordinates would be entered
as:

Latitude: 45.153333

Longitude: -111.583611
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Probe allows you to have several dynamic windows open at once,
these are generated when you create population reports, signal
tables, and when examining profiles with the profile viewer. You may
also have multiple instances of these windows open (for example
you could have two profile viewers open at the same time). Since
you can still access the main Probe window, these windows may
become hidden behind it. In order to bring them back up to the top
use the window list form. The window list form can be accessed by
choosing "Windows" from the "View" menu.

The window list shows all of the dynamic windows which are
currently open. To bring one of them to the top of the screen select
the window you want and click the "Show Window" button. The
window list form will remain on the top layer of the screen (you can
still access the main Probe window with the window list open). If you
wish to do a lot of switching back and forth between two dynamic



windows it may be handy to leave the window list form open and
place it down in the corner of the screen. To close the window list
form, press the "Close" button. Each dynamic window is listed by its
type. If there are multiple instances of the same type of window, the
windows created after the first instance will be followed by a number
in parentheses (the higher the number, the more recently it was
created). The picture shows a case where there are 2 Text Output
windows open. The one labeled "Text Output" was created first, and
the one labeled "Text Output (1)" was created second.

 



 

 

 

Exporting the Map to a Graphics File
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To create a graphics file (BMP, GIF, JPG, or PNG file) from a
displayed map, choose "Export Map to Graphics File" from the
"File" menu. The following window will appear:



Generate a new, non "page style" map

You can set the map settings in the window on the left (these
default to the current map settings). Use the switches on the
right side to select the resolution of the bitmap ( these are
formatted as "Width x Height" in pixels ). If you choose a
custom resolution, X is the width and Y is the height. The
defaults in the X and Y edit boxes are the width and height of
the current map being displayed. When the parameters that
you want have been entered, click the "Generate Bitmap"
button and you will be prompted for a file name.



When you export to a graphics file using this option you will
only get a "map" and not all of the "page" information (margins
and other map items that were only added to the page style
map) that you see on the screen.

Save the currently displayed map

This option will allow the user to save the map which is
currently displayed by the program exactly how it is (with
margins and legends).

Generating the Graphics File

When generating the graphics file, a standard save dialog box
will appear where you can specify the name and type of
graphics file you want to generate.



Use the drop down list box labeled "Save as type" to select the
type of file you wish to save to.
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Probe performs DTV/TV interference calculations as defined in
the FCC's OET Bulletin No. 69 and the Sixth Report and Order.
The following is a quick summary of this methodology as
implemented by Probe (see the previously mentioned
documents for more detailed information).

Stations to be Considered

To find possible interferers Probe begins by locating all
licensed TV transmitters within a distance from the reference
transmitter's site (this is 600 km for incoming interference and
1200 km for outgoing interference). All stations which do not
meet the distancing rules and channel spacing requirements
listed in Table 7 of OET 69 are eliminated.



Area of Calculation

In order to maximize calculation speed, Probe will only
calculate signal for points where interference may be
considered as per the distancing rules in Table 7 of OET 69.
This means that the area of calculation for an interfering
station will be within the overlap area of a circle around the
interfering station (the radius defined by table 7) and the
bounding contour selected by the user (this is the noise-
limited contour by default) of the station which is receiving
the interference.

Signal Calculations

After all of the stations to be considered have been loaded
and the study is created (by pressing the "Finish" button at
the end of the wizard), all transmitters in the study are set up
to use the calculation parameters defined in OET 69 ( Table 4
). These are as follows:



Propagation Model: Longley/Rice

Dielectric Constant: 15.0

Ground conductivity: 0.005

Refractivity: 301.0

Antenna Polarization: Horizontal

Climate: Continental Temperate

Receiver Height: 10 m

Situation Variability: 50%

Time variability: This is set to 50% for analog stations
receiving interference, 90% for digital stations receiving
interference, and 10% for stations being examined for



causing interference.

All signal values are stored in square cells (square with
respect to kilometer distance). You can specify the cell size in
kilometers on the first interference page of the wizard in the
box labeled "Resolution of Signal". If you specify a resolution
of "2 km", Probe will use a grid with cells that are 2 km high
and 2 km wide. OET 69 requires that the cell size be 2 km or
less. When calculating signal for a specific cell as per the
FCC method, Probe will use the population centroid of the
cell as the point of calculation (this population centroid is a
weighted average of the latitudes and longitudes of the
census blocks contained in the cell).

One thing that Probe does differently than the FCC relates to
it's choice of profile point spacing. OET 69 states that the
point spacing along a profile was one kilometer. Probe can
use a user defined profile spacing. The user can specify 0.1
km spacing along profiles for greater accuracy (this spacing
corresponds with the best possible detail given by 3 second
terrain data).

Signal values are calculated using the vertical elevation field
pattern defined in Table 8 of OET 69.



Interference Calculations

Interference is calculated for each cell using the U/D ratios
listed in the Commission's update of the Sixth Report and
Order. Before calculating the U/D ratios, a receiver antenna
pattern is applied as described in OET 69 ( page 11 ).

Outgoing Interference Considerations

When examining a transmitter's outgoing interference (i.e.
doing an outgoing interference study) the transmitter's signal
may cause interference to another station at a point where
interference from another transmitter already exists. Such a
point is called a "masked" interference point. There is a
switch on the first page of the wizard which determines
whether or not "masked" interference is reported as
interference.

Real World Interference Considerations



When using the OET 69 model to determine "real world"
interference (as opposed to for allocation purposes) it may be
desired to set the area of calculation to a distance that goes
beyond the reference station's noise limited contour. One of
the requirements of OET 69 is that KWX errors point be
considered as "interference free coverage". As a
consequence of this there may be cells that do not achieve
the signal threshold for reception, but are counted as
"interference free coverage" because of this requirement. It is
recommended that for "real world" interference calculations
that you turn on the "Do Not Consider KWX points as Ix Free
Coverage" switch.

 

 



 

Signal Progress Bar
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While signal is being calculated, a progress bar will appear at the top of the
Probe window. This progress bar indicates the calculation progress for the
transmitter which is currently being calculated (you can find out which
transmitter is being calculated by looking at the Transmitter List Box or the
application's status bar). The progress bar will go from zero to one-hundred
for each transmitter in the study. When signal calculation is complete, it will
disappear.
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Probe's data export feature can be used to save calculated field
strength values to a geocoded file. The data export window can
be accessed by choosing "Data Export" from the "Tools" menu.



The "Transmitter" drop down combo box is used to select which
transmitter's signal you wish to export. Then select the format
you wish to export to and press the export button.

Coverage Export Formats

V-Soft ASCII #1

This is a simple ASCII file format which is simply a list of
"latitude, longitude, field strength".



Sample

41.511111 , -94.644444 , 61.799534

41.528889 , -94.644444 , 58.445763

41.546667 , -94.644444 , 56.498852

41.564444 , -94.644444 , 58.065311

41.582222 , -94.644444 , 55.903187

41.600000 , -94.644444 , 66.788452

41.617778 , -94.644444 , 67.109291

41.635556 , -94.644444 , 43.940651



41.653333 , -94.644444 , 41.989079

V-Soft ASCII #2

This ASCII file format is a "buffer" style output with some
limited heading information. The first lines of the file define
the location, size of the buffer, and latitude/longitude
spacing between points. The data portion of this format
consists of a series of "scan lines" where each line
represents a latitude and the values on each line are the
values for each longitude at that latitude. The data portion
of the output is in a "bottom up" type format (where the
first scan line corresponds to the minimum latitude and
the last scan line corresponds to the maximum latitude).
Since many Probe studies are calculated in a non-
rectangular region, when being saved to a rectangular
buffer the points which were not calculated are given a
value of -1000.

Specification

1: Latitude of the lower left hand corner point



2: Longitude of the lower left hand corner point

3: DeltaLat (latitude spacing between points)

4: DeltaLng (longitude spacing between points)

5: Number of columns

6: Number of rows

7: the data begins on this line and continues "#6" lines

Sample

40.622222

-94.666667



0.017778

0.022222

110

115

-1000.000000 -1000.000000 -1000.000000 -1000.000000 ....

....

....

....

MIF Format

This will save the calculated signal as a set of polygons in
MIF (Map Info) format. There will be one region for each
cutoff defined on the map. After selecting a filename to
save to, the following window will appear:



The lower the render buffer precision is set to, the more
accurate the polygons will be - however the amount of
time and memory required to process will also be greater.

Exporting Interference Data

Interference data is exported in a format similar to the ASCII
#1 coverage format, except that it has extra data after the
field strength.

Sample:

43.822222 , -92.488889 , 55.611271, 999

43.840000 , -92.488889 , 51.795769, 999



43.982222 , -92.488889 , 53.653976, 999

44.000000 , -92.488889 , 57.003384, 999

44.017778 , -92.488889 , 43.634651, 1, 2, 3

44.035556 , -92.488889 , 49.889423, 999

44.053333 , -92.488889 , 29.518801, 999

43.751111 , -92.466667 , 45.141254, 999

If the first column after the field strength is 999 then the point
is an interference free coverage point. If it is not, then there
will be a list of transmitters that correspond to the text report
generated in the text editor when exporting the data.
Numbers that are less than 50 are for NTSC stations and
numbers greater than 50 are for DTV stations.
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There are several places throughout the program where data
can be saved to or recovered from the V-Soft reference file.
Many V-Soft programs can read from and write to this file
granting a level of connectivity between the various programs.
The path to the V-Soft reference file can be set using the Path
Setup window (note: this should be set to the same path in all of
your V-Soft software in order for them to communicate).

Reference Buttons:



 Write data to the V-Soft Reference File

 Read data from the V-Soft Reference File

The data which is written to or read from the reference file
depends on the type of data available on the current window.
The following are different types of data stored to the V-Soft
reference file:

Latitude / Longitude ( to the nearest second )

Call Letters

Class (for FM)

Channel



AMSL Height

HAAT (Height Above Average Terrain)

ERP

Directional Pattern
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